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DISC COVER END USER LICENSE AGREEMENT

THIS LICENSING AGREEMENT ("AGREEMENT") IS A LEGAL AGREEMENT BETWEEN YOU,
EITHER AN INDIVIDUAL OR A SINGLE ENTITY, AND BELIGHT SOFTWARE ("LICENSOR"). IF
YOU DO NOT AGREE TO EACH AND EVERY TERM, YOU ARE TO CLICK "DISAGREE" BUTTON
AND NOT TO OPEN, USE OR INSTALL THE SOFTWARE. YOU MUST EITHER RETURN THE
SOFTWARE, DOCUMENTATION AND PACKAGING TO THE PLACE OF PURCHASE OR, IN THE
CASE OF DOWNLOADED SOFTWARE, DELETE THE SOFTWARE FROM YOUR COMPUTER
AND/OR ANY OTHER DATA STORAGE DEVICE.

1. GENERAL

The software, documentation and any images or ready-made designs accompanying this
License whether on disk, on any other media (collectively the "Software") are licensed to you by
BeLight Software ("Lisensor") for use only under the terms of this License, and Licensor reserves
all rights not expressly granted to you. The rights granted herein do not include any other
patents or intellectual property rights.

Title and intellectual property rights in and to any content displayed by or accessed through the
Software belong to the respective content owner. This License does not grant you any rights to
use such content.

2. LICENSE

Licensor hereby grants to You, and You accept, a non-exclusive license to install and use
Software and Documentation, only as authorized in this license. The license permits either
multiple users to install and use the software on a single computer, or a single user to install
and use the software on multiple computers. The license doesn't allow multiple users to use the
Software on multiple computers. You agree that You will not assign, sub license, transfer,
pledge, lease, rent, or share Your rights under this license. You may not reverse engineer,
decompile or disassemble the Licensed Software for any purpose whatsoever.

Clip Art and Photo Images: The Software contains numerous clip art images and photo images
(collectively known hereafter as “Images”) that are either owned by Licensor or licensed from a
third party. You are free to use, modify and publish the Images as you wish subject to the
restrictions set out in this section. If you are uncertain about your rights to use any material,
you should contact your legal advisor.

You may NOT resell, sublicense or otherwise make available the Image(s) for use or distribution
separately or detached from a product or Web page. You may NOT a) create scandalous,
obscene, defamatory or immoral works using the Image(s) nor use the Image(s) for any other
purpose which is prohibited by law; b) use or permit the use of the Image(s) or any part thereof
as a trademark or service mark, or claim any proprietary rights of any sort in the Image(s) or
any part thereof; c) use the Image(s) in electronic format, on-line or in multimedia applications
unless the Image(s) are incorporated for viewing purposes only and no permission is given to
download and/or save the Image(s) for any reason; d) use any Image(s) except as expressly
permitted by this License; and e) use the Image(s) related to identifiable individuals, products or
entities for any commercial purpose or in a manner which suggests their association with or
endorsement of any product or service.

3. TRANSFER

You may not distribute copies of the Software including clip art images, photo images, ready-
made designs, in whole or in part, to any third party, nor may you use, rent, loan, sublicense, or
lease the Software to third parties. You may, however, transfer all your rights to use the
Software to another person or legal entity provided that: (@) You also transfer this Agreement,
the Software and all other software bundled or pre-installed with the Software, including all
copies, Updates and prior versions, to such person or entity; (b) You retain no copies, including
backups and copies stored on a computer; and (c) the receiving party accepts the terms and
conditions of this Agreement and any other terms and conditions upon which You legally



purchased a license to the Software. Notwithstanding the foregoing, You may not transfer pre-
release or not for resale copies of the Software.

4. ILLEGAL USE

You are not to use the Software, whether directly or indirectly, for any illegal purpose under the
laws or ordinances of Federal, State, or local governments. It is Your sole responsibility to
know and understand the laws and/or ordinances that govern the use of the Software. In the
event that You violate any Federal, State or local law or ordinance by direct or indirect use of
the Software, You shall take full legal responsibility for such illegal use. You shall hold Licensor
harmless and without fault and otherwise indemnify Licensor for any damage, cost or liability
incurred by Licensor as a result of any use, whether or not such use is within the scope of the
license set forth herein.

5. UPDATES

If the Software is an Update to a previous version of the Software, You must possess a valid
license to such previous version in order to use the Update. You may continue to use the
previous version of the Software on your computer after You receive the Update to assist You in
the transition to the Update, provided that: the Update and the previous version are installed on
the same computer; the previous version or copies thereof are not transferred to another party
or computer unless all copies of the Update are also transferred to such party or computer; and
You acknowledge that any obligation BeLight Software may have to support the previous version
of the Software may be ended upon availability of the Update.

6. LICENSOR'S RIGHTS

You acknowledge and agree that the Software and Documentation consists of proprietary,
published and unpublished property of Licensor. You further acknowledge and agree that all
right, title, and interest in and to the Software and Documentation are and shall remain with
Licensor. This license conveys to You the right to install and use the Software and
Documentation in accordance with the terms of this license. All rights not expressly granted
here are reserved by BeLight Software. The Licensor will not transmit your personal information
to any third party without your express consent.

7. TERMINATION

This license is effective upon Your installing the software on any machine, and shall continue
until terminated. You may terminate this Agreement at any time. The Licensor may immediately
terminate this License Agreement if you breach any representation, warranty, agreement or
obligation contained or referred to in this License Agreement. Upon termination, you must
dispose of the Software and all copies or versions of the Software by destroying the Software.

8. LIMITED WARRANTY

BeLight Software provides a thirty (30) day money-back guarantee on the Software. If, during
this period, you are dissatisfied with the Software for any reason, BeLight Software will refund
your money if you return the Software and all copies to the place of purchase within thirty (30)
days of the date of the original purchase. THE FOREGOING IS THE SOLE AND EXCLUSIVE
WARRANTY OFFERED BY BELIGHT SOFTWARE. BELIGHT SOFTWARE DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE
LICENSED SOFTWARE AND ALL ACCOMPANYING MATERIALS. BELIGHT SOFTWARE AND ITS
AGENTS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY
USING THE SOFTWARE.

9. LIMITATION OF LIABILITY

IN NO EVENT WILL BELIGHT SOFTWARE OR ITS AGENTS BE LIABLE TO YOU FOR ANY DAMAGES,
CLAIMS OR COSTS WHATSOEVER OR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL DAMAGES,
OR ANY LOST PROFITS OR LOST SAVINGS. BELIGHT SOFTWARE'S AGGREGATE LIABILITY AND
THAT OF ITS AGENTS UNDER OR IN CONNECTION WITH THIS AGREEMENT SHALL BE LIMITED TO
THE AMOUNT PAID FOR THE SOFTWARE, IF ANY.



10. FEES

The Software is available in download and CD versions. If your download version of the Software
does not come with a License Code, you may register your copy of the Software by purchasing a
License Code for the download version at: http://www.belightsoft.com/buy/ The License Code
will disable the restricted printing feature of the Software. By purchasing the CD version of Disc
Cover, your License Code is delivered to you together with the CD.

You may not distribute the License Code. By clicking "Agree", you acknowledge that you have
paid the Licensor all applicable license fees for the Software.

11. SEVERABILITY
Should any term of this license be declared void or unenforceable by any court of competent
jurisdiction, such declaration shall have no effect on the remaining terms hereof.

12. GENERAL PROVISIONS

This License Agreement is personal between You and BeLight Software. It is not transferable
and any attempt by You to rent, lease, sublicense, assign or transfer any of the rights, duties or
obligations hereunder. YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER
AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN
YOU AND BELIGHT SOFTWARE WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL
OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN YOU AND BELIGHT SOFTWARE OR
BELIGHT SOFTWARE'S AGENT(S) RELATING TO THE LICENSED SOFTWARE.

If you have any questions regarding this Agreement or if you wish to request any information
from BeLight Software please use the address and contact information included with this
product to contact BeLight Software.

© 2003-2006 BeLight Software, Ltd. All Rights Reserved. BeLight Software and Disc Cover are trademarks of BeLight
Software, Ltd. Mac, the Mac logo, Mac OS X, iPhoto, and Macintosh are trademarks of Apple Computer, Inc. Digital
image content © 1997-2006 Hemera Technologies, Inc., © 1994-2006 GSICO, Inc. All rights reserved. Avery is the
trademark of of Avery Dennison Corporation. All other trademarks, registered trademarks, product and/or brand names
are the sole property of their respective owners.
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Chapter 1
Introduction

Welcome to Disc Cover

Thank you for choosing Disc Cover - the program for designing and printing CD/DVD labels, inserts, booklets
and case covers. Disc Cover is compatible with the iLife applications - such as iTunes, iPhoto or iDVD. The
program supports a wide range of paper templates from the leading manufacturers and has a built-in printer
calibration tool to ensure accurate printing.

System Requirements

* Apple Macintosh computer (with PowerPC or Intel processor)

e Mac OS X v10.3 or later (Tiger compatible)

¢« 60 MB of available disk space (approx. 1.8 GB for full clipart install in case of the boxed version)
* CD-ROM drive (for boxed version)

*  Printer - inkjet or laser

Installing and Removing Disc Cover

To install Disc Cover (downloadable version):

*  Double-click the *.dmg file.
¢ Double-click the Disc Cover installer icon in the window that will appear.
* Follow the installer instructions.

To install Disc Cover (boxed version):

* Double-click the Disc Cover installer on Compact Disc 1 of 2.

e Follow the installer instructions.

¢  Double-click the Disc Cover installer on Compact Disc 2 of 2. The second disc contains additional clip art
that can be installed.

e Follow the installer instructions.

If you wish to remove the program from your computer please complete the following steps:

¢ Quit Disc Cover.

¢ Delete "Disc Cover" from the Applications folder.

¢ Delete the "Disc Cover" folder from "(Your Macintosh HD)/Library/Application Support/Belight
Software/". (If you don't have any other applications from BeLight Software installed, delete the "BeLight
Software" folder).

¢ Delete the "com.belightsoft.DiscCover.plist" file from the "~(Your Home)/Library/Preferences/" folder.

e Delete the "Disc Cover.pkg" file from the "(Your Macintosh HD)/Library/Receipts/" folder.

Note: by default, the program saves custom templates in:
"(Your Macintosh HD)/ Library/Application Support/BeLight Software/Disc Cover/My Templates". Don't remove this
folder if you are going to use your templates in the future.

BeLight Software, Ltd www.belightsoft.com 7
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Updating Disc Cover

From time to time Belight Software releases new versions of the product. To update to a new version it is
usually enough to install an update. Before launching the update installer, make sure the application and the
supporting files are in their default location. Normally they are — provided you simply followed the installation
procedure and didn't change paths or transfer files manually.

To check for the latest update choose Check for Updates... from the Disc Cover menu. If there is an update
available, you will be offered to download it.

Or you can visit the Disc Cover Updates web page:
http://www.belightsoft.com/disccover/update

Registration

To register Disc Cover, enter your License Code in the License dialog that comes up when you launch the
software, or under the Disc Cover menu choose License...

If you have already purchased Disc Cover from BeLight Software or its resellers, you'll find the License Code
in the purchase confirmation e-mail or inside the Disc Cover package (in case of the CD version).

To enter your license code (if it is in e-mail), copy it from purchase confirmation e-mail, then launch Disc
Cover and choose License... from the application menu; then paste the code into the dialog box that will
come up. It's recommended to save this e-mail in case you need to register the application after re-
installation or after update.

In the case of the CD version, enter the code manually. Be attentive not to use the 'O’ character, type only O
(zero) digit in the license code. There is also no small letter 'l', but only 1 (one) digit in the license code.

The unregistered version of Disc Cover is fully operational. The only limitation is that it prints the "Disc Cover
Trial Version" text at the bottom of each design that you print. To eliminate this text, you need to register
your copy of the software.

To move from the trial to the registered version of the program you need to purchase and register it. See
details on our web site:
http://www.belightsoft.com/buy/

Useful Web Resources

Disc Cover Page:
http://www.belightsoft.com/disccover
Information about Disc Cover, links to Download, Latest Update, Buy and FAQ sections.

Disc Cover Resources Page:
http://www.belightsoft.com/disccover/resources.php
Useful articles related to the usage of Disc Cover.

BeLight Software Web site:
http://www.belightsoft.com
Check it out for updates, new product announcements, special offers.

Buy Disc Cover:
http://www.belightsoft.com/buy
Here you can purchase Disc Cover.

BeLight Software Technical Support:
http://www.belightsoft.com/support
Visit this link if you have questions about the software.

BeLight Software, Ltd www.belightsoft.com 8
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Chapter 2
Getting Started

Disc Cover gives two ways to start a new project (document): using the Assistant and from scratch.

Using the Assistant, you can select the most appropriate template and fill it with data. The Assistant will help
you with import from iTunes, iPhoto and with getting file list from a folder on your hard disk.

Creating a new document

From scratch With help of the Assistant
(See Chapter 4, "Creating a New Blank Document")

Using the Assistant, you can select the most
appropriate template and fill it with data. The
Assistant will help you with import from iTunes,
iPhoto and with getting file list from a folder on your
hard disk.

(See Chapter 4, "Creating a Document from a Ready-
Made Template")

Editing a document

1. Adding or removing design elements. Design elements are discs, case covers, inserts and so on. They are
similar to pages in page layout programs. (See Chapter 5, "Working with Design Elements")

A blank document contains one disc design element, added by default. Templates from the Assistant have
several design elements.

2. Selecting paper for design elements. This is not necessary if you want to print on plain paper.
Creating custom paper layouts if needed.

(See Chapter 5, "Choosing Paper")

3. Modifying graphics and text. (See Chapter 5)
4. Importing data. (See Chapter 6)

Printing or exporting your document

Printing process depends on what layout/media will be used.

Pre-defined paper layout: you will print on special paper for CD labels, covers, etc. All dimensions are
defined by Disc Cover developer and correspond to standard paper from leading paper manufacturers.

Custom paper layout: created by user and may correspond to standard paper. Printing is the same as for
pre-defined paper.

Plain paper: no ready-made layouts are used. You put your design elements on standard plain paper in the
print window just before printing.

CD or DVD (direct CD/DVD printing): similar to printing on pre-defined layouts, but you need to make
additional printer settings.

(See Chapter 7, "Printing")

BeLight Software, Ltd www.belightsoft.com Getting Started 9
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Example 1: Designing a Music Disc

Content: Music (from iTunes)

Based on: Autumn Fire template from Assistant
Designed Elements: Disk Label, Disc Cover

Paper: Avery 5981, Avery 5693

In this example you will create a design for a music CD. The design will consist of two elements — the disc
label and the disc cover. The design will be based on one of the templates supplied with the program, with
the possibility to customize it later.

To design the CD label:

1.

Launch Disc Cover. The Assistant window will open (if it doesn’t, press Music | T]
Cmd+Shift+N). —
esign

In the drop-down list at the top choose the Music category. Then choose a m

template from the list on the left (e.g. Autumn Fire). Click Next.

A window will open, displaying your iTunes library. Select a playlist in the left part of the window; or
individual tracks in the right part of the window (use Cmd and/or Shift to select multiple items). Click
Finish, and the design canvas will open, containing the CD label design with the list of tracks.

Click the Change Paper... button on the Design Element tab of
Inspector, then choose CD/DVD Label or Disc in the Element drop-
down, and the paper make from the list beneath. Choose the paper Element: CD/DVD Label or Disc
size from the Size list. You may also type the paper model in the
Search field (Avery 5981 in this example). If printing directly to a
CD (your printer must support this feature), select the printer manufacturer from the Manufacturer list,
and then your printer model (set Size to All to see all printers). Click OK to close
the dialog.

Manufacturer: Avery

Size:  US H

n rl g
If instead of an iTunes playlist you want to import track names from a folder '-@ v u ]
containing MP3 files or from a Toast Audio Project, in the list of sources (near
the Import button) on the Source panel choose MP3 files or Toast Titanium, S Music Files | :]
respectively. You’ll be asked to navigate to the folder containing the MP3 files,

or to the project file.

The design contains graphics and two text blocks -
one with the title, and one with the track list. The
title has been taken from the album name (or
names, if your playlist contains a compilation from
several albums). To modify the title, double-click
on it and type in a new title (for example, My
Favorite Songs). To change the font and font size,
use the Font panel (Cmd+T).

My Favourite Songs

Your Woman (Marxist Mix) 5:55
The Fark 5:38

Slind Eya 3:34
The list of tracks has the default formatting, ;ﬁs:m 403

David Watts 238
English Rose 2:51
Devid Watls  2:56
God Only Knows ~ 2:51
Here Today  £:54
éfie-Tol 5:30
Ah L'amour, L'amour3:27
Genarator 1:50

inherited from the template. You can change it
using the Format list in the Source panel. For
example, to have the track names and their
duration formatted in two columns, choose Title
Duration. Then drag the text from the Source
panel onto the respective text box on the design.

You may work with individual columns easily (for
example, change font attributes). Switch to the
Text tab of Inspector and select the required
column in the list of columns at the bottom. The selected column will become highlighted in the text box.
Now you can change font, font size, color, etc. for the selected column with the help of the tools on the
Text tab, or using the Font panel (Cmd+T). The Line Up button lets you align the columns neatly. The
Default button reverts the columns to the default alignment.

BeLight Software, Ltd www.belightsoft.com Example 1: Designing a Music Disc 10
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9. To change the graphics of the CD, switch to the Background layer by clicking the Background tab at the
bottom of the main window. Now you can edit, remove or add the images forming the background of the
CD design.

To make the CD cover:

1. Switch to the CD Cover design element by clicking on its icon on the lower line of the
toolbar. The CD cover will be displayed in the main window, its design corresponding to 4 =l
the original template design.

2. If you're going to print the CD cover on plain paper, skip this step. Since we
have already decided to print on Avery 5693, type its name into the search box.
Note that the covers are different for different types of CD boxes, so make sure Size:  US i
you know what paper you're printing on. Click OK to close the dialog.

Element: CD Cover

3. To change graphics on the CD cover design, switch to the Background tab and do the necessary
changes. You may use clipart images, smart shapes or iPhoto images accessible from the Source panel,
or the tools found in Inspector (mostly on the Fill & Shadow and Image tabs). For more information see
“Working with Images and Smart Shapes” in Chapter 5.

4. The template also includes a design element for the CD tray insert. It's not needed for this example, so
remove it (switch to it and choose the File/Design Element/Delete menu command).

To print your design:

1. Switch to the CD/DVD Label or Disc design element by clicking on its icon on the lower line
of the toolbar. = o

2. Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

3. Your disc label design will be shown in the preview on the paper you have selected before. Usually paper
layouts have several elements. If needed, drag more elements from the left box onto paper layout. To
remove a label from the sheet, drag it outside its bound on the sheet.

4. |Insert a sheet of CD label paper into the printer and click the Next button. You will see the standard print
dialog. Make necessary settings and click Print.
If you print directly on a disc, make sure that "Media Type" is set to CD/DVD (Epson) or Printable disc
(Canon).

5. After sending the label to the printer the program will return back to the main window. To print the disc
cover, switch to the CD Cover design element.

6. Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

7. Your disc cover will be shown on the paper you have selected before. If you are using plain paper, select
it in the Paper list. To print cut marks and/or dotted marks, tick the corresponding boxes.

8. Insert a sheet of paper into the printer and click the Next button. Make the necessary settings in the
system print dialog and click Print.

BeLight Software, Ltd www.belightsoft.com Example 1: Designing a Music Disc 11
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Example 2: Designing a Photo Disc

Content: Photos (from iPhoto)

Based on: Collage — Snake template from Assistant
Designed Elements: Disk Label, Cover, Tray Insert

Paper: Avery 5981, Avery 5693

In this example you will create a design for a photo CD using the Assistant. The design will consist of several
elements — a disc label, a CD cover and a tray insert, and will be based on one of the templates supplied with
the program.

To design the CD label:
1.

Photos

Launch Disc Cover. The Assistant window will open (if it doesn’t, press

Cmd+Shift+N). S

Christmas Gift

In the drop-down list at the top choose the Photos category. Then choose a Collage - 3 Photos
template from the list on the left (e.g. Collage - Snake). Click Next. Collage - Random
Collage - Snake

A window will open, displaying the contents of your iPhoto library. Select a photo

album in the left part of the window; the pictures in it (with their titles) will be displayed in the right part
of the window (use Cmd and/or Shift to select multiple items). Click Finish, and the design canvas will
open, containing the CD label design with thumbnails of pictures from the album.

Note: The Assistant can import photos only from the iPhoto library. If you wish to use pictures from another
source (for example, from a folder on the disk), see “Importing Disc Content” in Chapter 6.

Click the Change Paper... button on the Design Element tab of

Inspector, then choose CD/DVD Label or Disc in the Element drop- Manufacturer: | Avery
down, and the paper make from the list beneath. Choose the paper
size from the Size list. You may also type the paper model in the
Search field (Avery 5981 in this example). If printing directly to a CD Size: | US ™

(your printer must support this feature), select the printer

manufacturer from the Manufacturer list, and then your printer model (set Size to All to see all printers).
Click OK to close the dialog.

Element: CD/DVD Label or Disc

You will see the Disc Label design element on the editing canvas. As this template
includes elements for two discs and some elements which you won’t need, delete + 7 [=
button on the

“w.on

unnecessary elements one by one by switching to them and clicking the
toolbar. Leave only the Label, Cover and Tray Insert
elements.

The design contains thumbnails of photos, the title
and date. The title has been taken automatically
from iPhoto’s album name. To modify the title,
double-click on it and type in a new title (for
example, My Favorite Photos). To change the font and
font size, use the Font panel (Cmd+T).

The date field is a special object containing the
current date in a specific format. To change the
presentation format of the date, double-click it and
choose another format from the dialog.

The thumbnails of pictures on the design act as
placeholders — you can select a picture on the design
and drag a new one (for example, from the Source
panel) over it, and the existing picture will be
replaced with a new one, the dimensions and
position of the placeholder preserved. It is
recommended that you use images of small size
(400x400 pixels and less), rather than full-scale photos. This will reduce the document size and printing
time.

BeLight Software, Ltd www.belightsoft.com Example 2: Designing a Photo Disc 12
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9.

You may also add other images, text or background to decorate your design. As a rule, it's convenient to
use the Background layer for background images and pictures that lay under text. Switch to the
Background layer by clicking the Background tab at the bottom of the main window. Now you can edit,
remove or add graphics forming the background of the CD design. For more information see “Working
with Images and Smart Shapes” in Chapter 5.

To make the CD cover:

1.

Switch to the CD Cover design element by clicking on its icon on the lower line of the
toolbar. The CD cover template design will be displayed in the main window. — ==

If you're going to print the CD cover on plain paper, skip this step. If you are

going to use a specific label paper, type its part number into the search box (in Element: CD Cowver
our case "5693"). Note that the covers are different for different types of CD
boxes, so make sure you know what paper you're printing on. Click OK to close
the dialog.

Size: US &

As the CD cover offers more space, you may wish to include more information than on the CD label — for
example, list the titles of all the photos or all the album names. To do this, select a text box on the
design (or draw a new one using the Extended Text tool), and from the Format list choose the needed
option (e.g. All Albums or Title), and drag the text from the field below the Format drop-down list over the
text box. If you don’t see the desired formatting option in the Format list, choose Other... and set up
custom formatting (see “Custom List Formats” in Chapter 6).

If needed, remove unwanted thumbnails (select them and hit the Del button), or replace them (selecting
a thumbnail and dragging a picture from the Source panel over it). Note, pictures may lay on the
Background layer.

If needed, add new graphics from Clipart, iPhoto or graphic file. They are accessible from the Source
panel. For more information see “Working with Images and Smart Shapes” in Chapter 5.

To make the CD tray insert:

1.

2
3.
4

Switch to the CD tray insert design element by clicking its icon on the lower line of toolbar.
If using special paper, set the paper in the paper selection dialog, as described above.
Change the text and graphics if needed as was described above.

CD tray inserts usually have the title on spines. To place text on spines, add a text box using the
Extended Text tool. Then type your text (for example, the year when the photos were taken and the
topic). Keeping the text box selected, use the Rotate controls on the Geometry tab of Inspector to rotate
the text box to 90 degrees clockwise or counterclockwise. Drag the rotated box onto the spine and resize
if needed.

To print your design:

1.

Switch to the CD/DVD Label or Disc design element by clicking on its icon on the lower line
of the toolbar. e

Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

The disc label will be shown on the previously selected paper. It is usually possible to add several
elements onto the sheet. To do this, drag extra elements onto free place holders. To remove a label from
the sheet, drag it away.

Insert a sheet of CD label paper into the printer and click the Next button. You will see the standard print
dialog. Make necessary settings and click Print.

If you print directly on a disc, make sure that "Media Type" is set to CD/DVD (Epson) or Printable disc
(Canon).

After sending the label to the printer the program will return back to the main window. To print the disc
cover, switch to the CD Cover design element.
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6. Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

7. Your disc cover will be shown on the paper you have selected before. Paper like Avery 5693 has a CD
cover and tray insert elements on the same sheet. So it is reasonable to print them together. For this,
drag both onto the sheet. If you are using plain paper, choose it in the Paper list. To print cut marks
and/or dotted marks, tick the corresponding boxes.

8. Insert a sheet of label paper into the printer and click the Next button. Make the necessary settings in
the system print dialog and click Print.
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Example 3: Designing a Video Disc

Content: Video (from iDVD)

Based on: From Scratch

Designed Elements: Disk Label, DVD Cover
Paper: Avery 5981, Plain paper (A4)

Disc Cover lets you create a design for your video projects. In this example you will design a label and cover
for a DVD containing video from an iDVD project.

To design the disc label template:

1. Create a new document (Cmd+N, or menu File/New). A blank disc label will open.

2. Set the paper you will be printing the disc label on, or the printer model is printing directly to disc (using
the Change Paper... button on the Design Element tab of Inspector, see the
examples above).

iDVD Project...

3. Toimport a list of DVD chapters, switch to the Video tab on the Source panel
(menu Window/Import/Video), click the iDVD Project button and navigate to the My Great DVD
iDVD project file. The name of the project and the list of chapters will display Memaries
below. My Birthday

Hiking Trip

4. To add the list of chapters to the design, click on it or drag it onto the document.

It will be inserted in your design as a text box. You may change font attributes, colors, etc., as for any
text block.

5. Now, let’'s add some graphics. Switch to the Background layer (View/Background). You can use images
from the clipart (Window/Clipart/Clipart Collection) for the background or use generators provided by
Image Tricks plug-in.

6. To generate a background (Image Tricks must be installed), choose the Effects
Window/ Clipart/ Image Depot menu item. Click the Generate... button at the Gathering |
bottom of the panel. The Edit Image window will show various generators. Brushes FRO
Choose the Gathering generator, and Star as the shape. You can change the _
density, size and shape of the stars using the respective controls. See the i _
results in the preview area on the right. The Render button re-arranges the Density: - -
elements in a random way. Clicking the OK button will add the generated ;;ﬁ—‘ 359 I
image to the design. Resize it so that it covers the entire disc. — 1

7. Switch back to the Foreground layer (View/Foreground). Now the text is Eﬂjﬁ—. "4 :
displayed over a nice background. You can add more clipart images, photos, ) -
etc. see “Working with Images and Smart Shapes” in Chapter 5 for more information.

Now when the disc label is ready, let’s proceed to the DVD cover. e

: i o+ K

1. Add the DVD Cover design element to the document. For this, choose the . s
menu command File/Design Element/Add/DVD Cover. A blank DVD cover S *F 2 g
layout will appear on the design canvas. It has the back and front pages and A ; ___' P ;
the spine between them. " '* o *f s 20k

* * * . = e

2. Inthis example, we will be printing the DVD cover on plain paper, so there is Pyl ST S
no need to select specific paper right now (you will set it later in the Print Ty b
dialog). 4 Y e ko

3. Switch to the Background layer and add some graphics to the design (you may use Smart Shapes,

clipart images, generated backgrounds, etc). See “Working with Images and Smart Shapes” in Chapter 5
on how to work with graphics. Then switch to the Foreground layer and add the title and other text (for
example, text descriptions to the movies which are on the disc). Once you're through with designing, you
can proceed to printing.
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To print your design:

1. Switch to the CD/DVD Label or Disc design element by clicking on its icon on the lower line
of the toolbar. il —

2. Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

3. The disc label will be shown on the previously selected paper. It is usually possible to add several
elements onto the sheet. To do this, drag extra elements onto free place holders. To remove a label from
the sheet, drag it away.

4. Insert a sheet of CD label paper into the printer and click the Next button. Make the necessary settings
in the system print dialog and click Print.

5. After sending the label to the printer the program will return back to the main window. To print the disc
cover, switch to the DVD Cover design element.

6. Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

7. To print the DVD cover, select the plain paper from the Paper drop-down list at the top of the dialog (A4
Plain). Enable the Cut marks and/or Dotted marks options so you can easily cut the cover from the
sheet of paper.

8. Insert a sheet of plain paper into the printer and click the Next button. Make the necessary settings in
the system print dialog and click Print.
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Example 4: Designing a Data Disc

Content: Assorted data
Based on: From scratch
Designed Elements: CD Label, CD Folding Booklet
Paper: Custom, Plain

A data disc can contain a variety of files or folders of assorted types. The most common example is a disc
containing a backup of your files.

To create a disc label:
1. Create a new document (Cmd+N, or menu File/New). A blank disc label will open.

2. In this example we will use custom paper layout for disc labels. This is reasonable if your label paper is
not currently supported by Disc Cover or if you want to make non-standard composition of elements. To
configure custom paper, click the Change Paper... button on the Design Element tab of Inspector.
Switch to the Custom tab. Click the Create... button below.

3. In the dialog set the size corresponding to your paper (e.g. Letter, A4 or enter the dimensions of the
paper you are using in the respective fields). The Design Element Source area contains a selection of
standard elements, which you can drag to the sheet on the right. Arrange the elements exactly as they
are on your label paper (measure the distances from the top and left edges of the sheet for each
elements, and use the Position fields to enter the offset). If the elements on your paper don’t match any
of those provided, you can create a custom design element (click the Manage Custom Elements button).
For more information about custom elements see “Creating Custom Design Elements” in Chapter 5.
Once the layout is ready, click OK to close the dialog.

4. Decorate your label with graphics and text (see previous examples, or “Working with Images and Smart
Shapes” in Chapter 5).

To create the folding booklet:

1. Add the Folding Booklet design element to the document. For this, choose the menu command
File/Design Element/Add/CD Folding Booklet. A blank booklet layout will appear on the design canvas.

2. In this example, we will be printing the folding booklet on plain paper, so there is no need to select
specific paper right now (you will set it later in the Print dialog).

3. To create a list of files or folders on the disc, switch to the Data and Files tab of the Source panel (menu
Window/Import/File&Folder List). Click the Folder... button. The file dialog will open, asking you to
specify a folder containing files and folders that will be on the disc. If your data has been already burnt,
insert the disc into the optical drive and choose it in the file dialog. Otherwise choose the folder
enclosing the files that will be burnt. Click Choose.

4. A window will open showing the folders in the left Tl e R

part of the window, and the contents of the selected Falders File Name
folder — in the right part. Use the triangles near the v/ v

name of folders in the left part of the window to — [ L
expand or collapse them. I\Fl)ote, that only the files }| i Address _EDO‘
and folders (and their subfolders) displayed in the Jivx | Applecript
right part of the window will be imported. Click p| 1 AppleScript ||| & Automator
Import. | Calculator

B iGetter 2.5
5. Alist of files and folders in the default formatting will B
be shown on the Source panel. To add the list to the design, click on it.
You can change its formatting using the Format drop-down list in the Source panel. For example, you
may want to display just the names of folders or folders and filenames, etc. Choose the desired

formatting style, then drag the text from the Source panel onto the respective text box on the design.
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6. You may resize the text box, change font size and attributes as with regular text boxes (see “Working
with Text” in Chapter 5). If the list of files is too long and doesn’t fit well in one text box, you may divide
it in two linked columns, to place on both “pages” of the booklet. When text goes beyond a text box, it
displays a red “plus” on its side. Click on this plus and draw another text box on the other page of the
booklet. The remaining text will flow into the second text box. For details see “Linked Text Boxes and
Flowing Text” in Chapter 5.

7. Decorate your booklet with graphics if needed (see previous examples, or “Working with Images and
Smart Shapes” in Chapter 5).

To print your design:

1. Switch to the CD/DVD Label or Disc design element by clicking on its icon on the lower line
of the toolbar. e

2. Call the Print dialog (File/Print). You will see a preview of the design elements in your document in the
left part of the dialog.

3. The custom paper you have previously created will be chosen automatically. You will see the layout of
the paper sheet and a disc label on it.

4. Insert a sheet of your label paper into the printer and click the Next button. Make the necessary settings
in the system print dialog and click Print.

To print the folding booklet, switch to the Folding Booklet design element.

6. Choose the plain paper from the Paper drop-down list at the top of the dialog (US Plain or A4 Plain).
Enable the Cut marks and/or Dotted marks options so you can easily cut the booklet from the sheet of
paper.

7. Insert a sheet of plain paper into the printer and click the Next button Make the necessary settings in the
system print dialog and click Print.
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Chapter 3
Program Interface

The Main Window

When you create a new blank document or finish working with the Assistant, the main window opens. It
consists of two parts: the design canvas where you do the editing, and the Source panel, which contains
playlist data and images (its appearance differs slightly for different types of data).

DESIGN ELEMENT CONTROLS ~ TOOLBAR RULER
8eo8n Lintitled
SOURCE & & & @ X El WH >

PAMEL
T Masic a =2

Formal. | |= Tide *'

Surlin’ SE°EA, Ayl &y
igraslites. 24 Fouws From
Tulsa, Dimples. W Do
Vit Love, Lannmniog

ALBUM (==
ARTWORK

F
%, Euwfin’ Safani Painewy

s

I=aeline s 24 Heawrs Fr -

=

Frragres.md

| Box

LAYERS . DESGIN ELEMENT

The design canvas has two layers: the Foreground and the Background. To choose the active layer, click on
that layer’s tab at the bottom of the design canvas. When you're working with one layer, you can’t select or
modify objects on the other layer, though you can normally see them.

The design canvas can also display the Ruler.

At the top of the design canvas you can see the toolbar. It consists of two lines.
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The top line has the following buttons:
T
2, R A OO0 vz

¢ Show/Hide Source Panel
Displays or hides the Source drawer
¢ Selection tool
The tool with which you select and move objects
¢ Extended Text tool
Use it to draw text boxes, including linked text boxes where text flows from one box to another
¢ Circle Text tool
Use it to draw circular text (often used for CD labels)
¢ Rectangle tool
Use it to draw rectangles and squares
e Circle tool
Use it to draw circles and ellipses
¢ Line tool
Use it to draw lines

Other buttons are:

e L + = a i
AE s O UA
¢ Print
Opens the Print dialog for printing out your layout
¢ Insert Picture
Inserts a picture from a file
e Zoom In and Zoom Out
Change the magnification in the document window
¢ Inspector
Shows or hides the Inspector window
e Colors and Font
Display the system Colors and Font dialogs

These buttons are customizable — you can remove some of them or reorder them using the Customize
Toolbar... command from the View menu.

The second line of the toolbar contains the following buttons:
b T - 1 4

¢ Add Design Element
This button opens a drop-down menu allowing to select a design element (e.g. Cover, Tray Insert,
Folding Booklet) to be added.

¢ Remove Design Element
Removes the current design element.

¢ Design Element icons
Icons represent design elements from your document. Click on an icon to show the corresponding
element in the editing window.

* Toggle Preview Mode
Displays or hides objects’ borders and margins.

For the description of the Source panel see “The Source Panel” section.
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The Source Panel

The Source panel gives access to sources of graphics and text data that can
be used in your designs. The panel consists of 5 tabs:

Music

Lets import a track list from iTunes, from a folder with MP3 files and
artwork images from iTunes and Internet.

Photos

Lets import images and image titles from iPhoto and images from a
folder on your computer.

Sl iTunes -¢! Import...

|12 Title Durat... |'5)

Format:

Generator1:50
Ah L'amour, L'amour 3z

R Video Méfie-Taoi 5:30
. . . . . God Only Knows — 2:51
Lets import graphics and titles from an iDVD project. Here Today 254
* Data and Files English Rose  2:51
Lets create a list of files from the selected folder and import data from a David Walts ~ 2:56
text file.
e Clipart E

Gives access to the internal clipart as well as to graphics on your hard
disk. The Clipart tab has the options shown below:

gD & @ ¥
D (2 (R (2 r’|'\.

J '\.?./F '\.:_3./" I\i’l '\.E_}./’
1. Internal image collection.
2. Smart Shape collection.
3. Custom Folder. It shows images from a folder on your hard disk. Use the Browse button to select a folder.

4. Image Depot - customizable collection of images and the source of Images generated by the Image Tricks
plug-in.
5. Collage Templates. Includes artistic place holders which you can substitute with your own images.

More information about each of the tabs is provided in Chapter 6 “Importing Disc Content”.
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The Inspector Window

The Inspector window contains the main set of tools for editing objects in Disc Cover. The tools are
distributed over six tabs: Design Element, Geometry, Fill & Shadow, Image, Text and Alignment. These
tools allow you to modify properties of selected objects: size, position, color, etc.

The function of each control in Inspector is described more detailed in the sections dedicated to objects.

The Inspector window can be activated through the menu Window/Inspector/(tab name) or by using the
Inspector button on the toolbar.

The dimensions are shown in the default units of measure as set in the Preferences dialog (see “The
Preferences Dialog” in Appendix A).

&) Design Element

The Design Element Tab = =
g o il % [ = T |%

The Design Element tab has the following sections:

Margins
Margins — sets the outer and inner margin (applicable to disc labels only). : -
The Cause Text Wrap control sets whether text in text boxes will be wrapped Outer: 3.3 | mm {2
with respect to the margins. Inner: 3.5  mm %
Hole Size - lets you switch between the small or large hole size (applicable ¥ cause Text wrap
to disc labels only). e
Design Element — displays a picture of the current design element (the one @ small ) Large

of blue color). )
Design Element
Type — shows the type of the current design element.

The Change Type list lets you quickly change the type of the current design
element.

Paper shows the selected paper type — either standard (A4, Letter, etc.) or
special paper made by various manufacturers. The Change Paper... button
brings up the Paper Selection dialog allowing you to choose the paper you’ll
be printing on.

Type: CD/DVD Label or Disc

Change Type -v!

Paper: Standard

Change Paper...
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The Geometry Tab
The Geometry tab has the following sections:

Position - shows (and lets you enter) horizontal and vertical coordinates of the
selected object.

Size - shows (and you can enter here) horizontal and vertical size of the
selected object.

If Fix aspect ratio is checked, the object will retain the width to height ratio
when you resize it. To restore the original size of an image, select it and click
the Original Size button.

Rotate - you can see and change the rotation angle of the selected object.
Flip mirrors the selected image or Smart Shape.

The Circular section controls object's angle and offset from the centre of the
design element.

The Smart Shapes section has two slide bars: Curve and Side Count. You can
adjust the attributes of some Smart Shapes. Their behavior depends on their

type.

The Fill & Shadow tab

Objects in Disc Cover can have filling, border line and shadow. These features
can be enabled/disabled and their parameters adjusted on the Fill & Shadow
tab.

In the Fill section, you can set color and opacity of the selected object's fill.
In the Line section, you can set up color and width of the object's border line.

In the Shadow section, you can set color, angle and blur of the shadow and
distance between the shadow and the object.

DISTAMCE 8 DISTAMCE &8 DISTAMCE 20 DISTANCE 20
BLUR 18 BLUR 3 ANGLE 135 ANGLE 200

For more information about working with images, see “Working with Images
and Smart Shapes”.

] Ceametry

r—

i sl =]
Lo il Q) | = T ||:|
Position

¥ 49.36 mm -
Y 79.08 mm x

Size
Width  35.20 mm [+
Height 39.20 mm

E Fix aspect ratio
QOriginal Size

Rotate

—— :
R A L G

-180° o 180"
Flip: é]"_\ ~
Circular
Angle: -

Offset! oo f e

Smart Shape

Curve:
Side Count:
©
6] Fill & Shadow
e
1 . | = =]
oM ® E T ||:|
™ Fill
Opacity 50 *
! A !
™ Line
Thickness L.oo
— e
Pattern: —-:!
M shadow
Distance:
e (14 | pt
1 s 1 1
Angle: (o 135 °
L oa—
Blur o 10 pt
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The Image tab
Use the Image tab to control attributes of the selected image.

When the Tint Image checkbox is checked you can adjust tint color and
opacity. Click the color button on the right to have the Colors panel opened.

Images can be masked with other images. Check the Mask checkbox and
select a mask from the list below. To use a custom mask, drag an image into
a custom mask box or click the Browse... button to load a picture from a file.

To change the opacity of the selected image, use the Opacity slide bar.

The Tile Image checkbox enables the creation of multiple small copies of the
selected image in the rectangle, which that image takes. This feature can be
used for decorating your designs. Use the Tile slide bar to adjust the number
of tiles and their size.

The Edit button opens the Edit dialog box. It has tools for editing pictures.

For more information about working with images, see “Working with Images
and Smart Shapes”.

O Image

] Tint image |l

E Mask image

Opacity:  s———t

1 Tile
Edit...
The Text Tab 6) Text
1 . [ =]
Use the Text tab to control the text attributes. o N D‘-) ET |‘:'
The Format section lets you select text alignment and color. The alignment Format
can be applied to the entire text box or to the selected paragraph. The color Align: g =|=
can be applied to the entire text or to any part of it.
T lor:
The Size slide bar changes the font size of the selected piece of text. et oot
The Fonts button opens the Font panel. sz 100
In the Spacing section you can set the spacing between characters, lines and AlA -
paragraphs. Also, you can set the size of margin between the text and text box Spacing
border. "
Between Characters: 0.0 -
To format a paragraph as a list, select the paragraph and choose the list type Between Lines: 0o :
in the List section. ' ' “
The Columns section controls the arrangement of columns when the imported Safore Paragraph: 0.0 o
text has several columns separated by tabs (for example, song title, album Inset Margin: 0 :
title, artist, etc.)
See “Working with Text” to find details about setting parameters of text. List
Lists "I
Columns
Line Up Default
Select Column by Name
Title
Curation
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The Alignment Tab

=) Alignment
In the Alignment section you can select how to align selected objects. Two = hE T ‘D
or more objects must be selected for alignment to be performed. o il 0 E -
The Distribute section allows you to make equal spacing between object Alignment

borders or between their centers. Three or more objects must be selected.

E | = 0| =l
The buttons in the Circular section distribute objects in a circular or radial | | m—

way. =i $
The Move To section allows you to center objects with respect to the
horizontal or vertical axis passing through the center of the page. Distribute
For more information, see the “Common Operations on Objects” section. ==
Circular
o3
Mowe To
HE
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Other Dialogs

There are some other dialogs related to some specific functions of the program. Here we are giving just a
brief overview of them, a more detailed description can be found in the respective sections of this manual.

The Print Dialog

This dialog lets you choose the printer and design element(s) to be printed, as well as some other settings.

The Paper Selection Dialog

In this dialog you can set the type of pre-defined paper template you will be printing on (e.g. Avery). To open
the dialog, use either the Change Paper... button on the Design Element tab of Inspector, or the Select
Paper Format... button from the Print dialog. If you are printing a disc label directly on the CD or DVD, use
this dialog as well (choose CD-R from the Size drop-down list, and then the printer model from the list
below).

If you are printing on plain paper (e.g. A4 or US Letter), you don’t need to use this dialog — select such paper
from the Print dialog.

More details on the Paper Selection Dialog can be found in the “Choosing Paper” section in Chapter 5.

The Custom Paper Layout Dialog

In this dialog you can create a custom paper layout and save it for future use. This is very convenient if you
are using label paper, which is currently not supported by Disc Cover. All you need to do is recreate the
positions and arrangement of the elements on the paper sheet with the help of this convenient dialog, and
save the layout. You will be able to choose it at any time later.

More details on the Custom Paper Layout Dialog can be found in the “Custom Paper Layout” section in
Chapter 5.

The Printer Calibration Dialog

The Printer Calibration dialog is used to adjust your printer to specific paper. If you print using the default
settings, the image might get offset. Then you need to use printer calibration to fight such unwanted offset.
Normally, it’s enough to calibrate the printer only once (or sometimes once for each specific type of paper).

More information on using printer calibration can be found in the “Printer Calibration” section of Chapter 7.

The Custom Format Dialog

This dialog helps you to set custom column formatting for imported text (for example, track lists imported
from iTunes). The program offers some default settings, and if you need anything not covered by them, you
may customize the names and number of columns using this dialog.

For more information on using this dialog see the Chapter 6 “Importing Disc Content”.

The Preferences Dialog

This dialog contains application-wide settings such as units of measure, whether to open the Assistant on
start-up, etc.

For more information see “The Preferences Dialog” in Appendix A.
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Chapter 4
Working with Documents

Creating a Document from a Ready-Made Template

Disc Cover features the Assistant - a special tool for choosing ready-made designs and filling them with
necessary information. To open the Assistant, use the File/New From Assistant... menu command
(Cmd+Shift+N). If Open Assistant at start-up is enabled in the program’s preferences, the Assistant will be
launched at start-up.

Text and graphics from the selected template can be modified once the Assistant has been closed and the
program switched to the editing mode.
Step 1. Choosing a Design

The list of available designs is shown at the left part of the Assistant window. Templates are organized by
categories: Music, Photos, Files & Data, General and Blank. The drop-down list above lets you select a category
or display templates from all of the categories.

eon Disc Cover Assistant

Please choose a design.

aw
i

Music

Cesign

Cracked Album

Disc Saw

Exotic Butterfly

Fun Party a
Funny Mess

Cold Line Collection
Creen Love

Guitar Playing

Jazz Colors

Jazz Concert

lazz

Latino
Moon Might
Random Circles -
Red

Running Keyboard

Sound of Guitar 1
Sounds A

-':?- . New Blank . Open Recent q . Finish - f Mext }

The selected design is displayed in the preview area. A template, as any Disc Cover document, can consist of
several design elements (for instance, CD label, tray insert, booklet, etc). Icons of the design elements
included into the template are shown above the preview. To see a particular design element, click on its icon.
You can also use the scroll arrows.

Once you have found the design you need, you can:

¢ Go to Step 2 by clicking the Next button. Step 2 will let you import data corresponding to the selected
template category (Data, Music or Photo).
¢ Close the Assistant and open the selected template for editing. Click the Finish button to do this.
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The Open Recent drop-down list lets you quickly choose one of the recently edited documents. This will skip
the Assistant and open the selected document.

The New Blank button skips the Assistant and opens a blank document.
Choosing a Custom Design
Your own templates can be also displayed in the Assistant.

The My Templates category at the bottom of the category list at Step 1 lets you

All

view the custom templates you have created and saved (in the default folder).

The Custom Folder... category lets you specify a folder other than default one for rhujt';s

templates and documents to be displayed in the Assistant. The Open File dialog Files&Data

will open letting you specify the path. | Ceneral |
Note: If you select a custom template, the program will offer you to import a track list Blank

from iTunes at Step 2. To import from other sources, skip the second step (click Finish)
and use the Source panel when in the editing mode. Custom Folder |

Step 2. Importing Data
The second step is intended to help you with adding textual and/or graphic data to your document.

At this step the Assistant behaves depending on what template category has been selected at the first step:

¢ Files & Data
e Music Disc (and custom templates)
* Photos

If you have chosen a design from the General or Blank category at Step 1, the second step of the Assistant
will be skipped.

Note: When Assistant is closed, you can import data using the Source panel.

Files & Data

A data disc is supposed to contain any computer files: Select Files or Folders to import.
databases, texts, spreadsheets, multimedia (music, video) Foldens File Name
and other. These may be mixture of different kind of files. In v/ Jivx

this case, the program will import the names of files and

folders to reflect the disc content. This may be useful, for F Applications

\ Address Book

|
example, if you're making a backup of your data and want to Jivx | AppleSeript
print the list of files and folders on the disc, case cover or »| | AppleScript ||| & Automator
booklet. ' Calculator
I

b iGetter 2.5

Select a folder when the program asks for this, and the
Assistant will show the folder name on the left and a list of its subfolders and files on the right. Click on the
triangle near the folder name at the left part of the window to expand it and view the enclosed folders and
files. Select the files and folders which names you plan to use in your design. You may use the Shift and Cmd
keys for multiple selection.

You may also use the Search field to find specific files.

When the selection is made, click the Finish button
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Music Disc
The program imports a list of tracks from iTunes.

In the window you will see your iTunes library and play lists at the left part. Click on Library to display all the
tracks in the library at the right part of the window, or on a playlist to display the tracks in this playlist only.

Select Maylists or Titles to import. Search:
Play Lists A Title Artist Time Album Year
Librar\,r 1 English Rose The Jam 2:51 AllMod Cons 1978
7 Podcasts 2 David Watts The Jam 2:56 AllMod Cons 1978
@Videos 3 God Only Knows The Beach B... 2:51 Pet Scunds 1866
ﬁa Party Shuffle 4 Here Today The Beach B... 2:54 Pet Sounds 1966
|é| 90°s Music 5 Generator Elastica 1:50 Menace 2000
|£| My Top Rated = Méfie-Tai Myléne Farmer 5:30 Innamoram... 1999
|i| Recently Added 7 David Watts The Kinks 2:38 The Singles ... 1987

Iﬂ Recently Played |8 Your Woman (Marxist Mix) White Town 5:55

|g|Top 25 Most Pl: 9 The Park Uriah Heep 5:38 Salisbury 1871
10 Blind Eye Uriah Heep 334 The Magicia... 1972
11 Tales Uriah Heep 4:08 The Magicia... 1972

It's also a good idea to use the Search field to find specific tracks only - for example, to limit the tracks to a
particular artist or album.

To import all the tracks displayed in the list to the right, click the Finish button.

To import only some of the tracks, use the Shift and Cmd keys to select the needed tracks, then click Finish.

Photos

The program lets you import pictures from your iPhoto Select Albums or Photos to import.
library. AIGTE

The left box shows photo albums, the right one shows
thumbnails and titles of photos from the selected album. [ Last Roll

To import all the photos from the selected album, click the ELast 12 Mon‘hs
Finish button. [@/j0urney to Chin

To import only some of the photos, select them in the .
preview (you may use Shift and Cmd for multiple selection). Journey to China - 25
Then click Finish.

The Assistant will close and the program will switch to the editing mode. Now you can continue modifying
your document (see Chapter 5 “Editing Documents”) or print it (see Chapter 7 “Printing”).
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Creating a New Blank Document

There are several ways of creating a new blank document.

e If the Assistant is open, click the New Blank button to skip all the steps of the Assistant and open a
blank document.

e If Assistant is not activated, choose the File/New (Cmd+N) menu command to create a new blank
document.

¢ When Open Assistant at start-up is disabled in the program'’s preferences, a blank document will be
created when you launch the program.

A blank document will contain a disc design element only. You will be able to change its type and add more
design elements if you need. On how to do this see the “Working with Design Elements” section of Chapter 5.

On how to edit your document see Chapter 5 “Editing Documents”.

Note: If you already know what kind of paper you will use for printing, select it in the Paper Selection dialog for every
design element you have added to the document. To open the Paper Selection dialog, click the Change Paper...
button on the Design Element tab of Inspector.
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Opening an Existing Document

To open an existing Disc Cover document, choose one of the following methods:

¢ If the Assistant is opened, click the Open... button to skip all the steps of the Assistant and open a
previously saved document.

¢ If Assistant is not activated, choose the File/Open... menu command (Cmd+0).

¢ Or click on your document's name in the list in the File/Open Recent menu.

¢ Finally, you may double-click the document's icon in Finder.

Navigate to the file using the file dialog, select it and click the Open button.

This applies only to the documents created in Disc Cover. If you want to open a graphic file to insert it into
you Disc Cover document, use the Insert/Image/From File... menu item.

Note: If you have forgotten the name of your Disc Cover document and the document is not listed in the File/Open
Recent menu, try to find it in Finder or Spotlight by the file extension "dcover".

Saving a Document

To save a document, choose Save from the File menu. If it’s the first time you're saving a new document, the
program will ask you to specify a name for it and a location where to save it.

To save a document, which has already been saved, under a new filename, choose Save As... from the File
menu.

You may also save a document as a template so it can be used later as a base for new documents. To do
this, choose Save As Template... from the File menu. For more information see the “Working with
Templates” section below.

In some cases you may need to save your document in PDF, TIFF or JPEG file Copies: 1
formats, rather than the original Disc Cover format. For this, use the File/Export

. . . Pages: @ All
menu command. This may be helpful if you need to show your design to somebody

or to order printing in a print shop. - From: |1
Another way of saving your document as PDF: Start printing and click the PDF
button in the system Print window. You will get an extended list of "save as PDF" PDEv ) ( Preview )

options.

Note: Documents exported to the PDF, TIFF or JPEG file formats cannot be edited later unlike documents in the Disc
Cover file format.
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Working with Templates

Templates are special kinds of documents, which can be used as a base for new documents. When you
create a new document from a template, the program creates a copy of the template so you can change it
without modifying the original document.

The collection of ready-made templates is available from the Assistant. They are grouped by categories, such
as Music, Photos, Files & Data, General and Blank. To choose a category, use the drop-down list at the
upper left part of the window.

a8aen Disc Cover Assistant

Please choose a design.

Music

[
[

Design
Cracked Album
Disc Saw
Exotic Butterfly
Fun Party i )i
Funny Mess

Gold Line Collecticn __“ ‘:' : LEGENDS

Creen Love

Guitar Playing ..

Jazz Colors E

Jazz Concert

:

lazz

Latino
Moon Might
Random Circles d
Red

Running Keyboard

Sound of Guitar a

Sounds T

(7)  ( NewBlank ) | Open Recent v ( Finish ) € Next )

Each category contains a number of templates, their names are displayed in the list at the left, and a preview
—on the right. Most templates provided with the program already contain several design elements — such as
the disc label, the cover and the tray insert.

You may also create templates of your own and use them as the base for Please choose a design.
future documents. To save your document as a template, choose the Save as =
Template... command from the File menu. The program will offer to save the S i '+
template in the My Templates folder (~(Your Home)/Library/Application Design
Support/BelLight Software/Disc Cover/My Templates). If you save your Mini-Disc Template

templates in this default folder, then they will appear later in the My
Templates category of the Assistant.

Of course, you may save templates in some other folder. In this case, if you want to access them from the
Assistant, choose the Custom Folder category there and navigate to the folder with your templates.

Apart from templates containing ready-made graphic designs, there is a Blank category. Templates there
contain sets of blank design elements and can be used if you wish to create a design from scratch.
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Chapter 5
Editing Documents

Working with Design Elements

CDs have several standard sizes (Standard CD, Mini CD). Cases for CDs and DVDs also differ in size and
construction (the standard "jewel case", slim, double, DVD case, etc.). This is why there are so many types of
CD labels, case covers and inserts.

A Design Element is a template of a disc, cover, insert, etc. It shows the outlines of
the physical object it represents. The program has various templates that match
label paper from various manufacturers.

You can add design elements to and remove them from your document using the
toolbar, or using the File/Design Element menu.
+ * [= L, g

Some tools for working with design elements are located on the Design Element tab of the Inspector window.
Disc Cover operates with three kinds of design elements:

1. Predefined design elements are preset for a specific sort of paper. All the dimensions of such a design
element are rigidly predefined by the selected paper. When you print your document on label paper, you will
need to select this paper in the program.

It is recommended that you select the correct paper type BEFORE you start working with a document. To view
the list of supported paper and select the one you will use, do one of the following:

¢ In the Paper Selection dialog (the Change Paper... button on the Design Element tab of Inspector);
¢ Or from the Print dialog (using the Paper drop-down list or the Select Paper Format... button).

Disc case inserts and covers may have different sizes. Apart from that, the position and quantity of labels and
inserts on a sheet are also different for different types of paper. Only after selecting a specific paper type, the
program will know how to print your document.

2. Program-predefined design elements do not correspond to any particular kind of paper, they have the
most common dimensions. Use them for printing on plain paper (like US Letter or A4) or directly on discs.
The paper type will be indicated as "Standard". This type of design element is used in the program by default.
Plain paper ("US Plain" or "A4 Plain") can be selected in the Print dialog.

3. Custom design elements. Use them if you need to define dimensions by yourself.

A Disc Cover document can contain several design elements. This allows you to save a disc label and both
front and back covers for its case in a single document. It is possible to have any combination of design
elements in a document.

When you add a new design element, its icon appears on the toolbar. You can switch
between design elements by clicking on their icons. Or you can move from one design 4 (g 3
element to another by clicking the left or right "arrow" toolbar buttons.

Usually several elements are located on a paper sheet. They can be identical (for example, two disc labels) or
different (front and back covers). If you're using several different design elements in your document, they can
be either printed on a single sheet of paper or you may distribute them across several sheets and print
separately.

Each Disc Cover design element has two layers: Background and Foreground. In fact, you can use only one
layer for designing. Background is usually used for background images and decoration, Foreground - for
textual and graphical data.
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To switch from one layer to another, use the tags at the bottom of the document view or the View/Background
and View/Foreground menu commands.

All objects (such as text and pictures) are placed on design elements. Disc holes and fold lines are marked on
design elements to help position objects correctly.

Adding and Removing Design Elements

To add a design element:

Click the Add toolbar button ¥ to bring up the pop-up menu.

Choose the desired design element’s type. Custom design elements (if you created any) will be shown at the
bottom of the list of elements.

The added design element will have the "Standard" paper type. You can change the paper type at any time.
Another way of adding a standard design element is choosing it from a particular sort of paper.

Click the Add toolbar button and choose the Design Element From Paper... command. Then select paper and
a design element on it. See details in the “Choosing Paper” section later in this chapter.

To delete a design element, select its icon on the toolbar and click the Remove button =,

Note: A document must have at least one design element, thus removing the last design element is impossible.

Changing Parameters of a Design Element

Parameters of the active design element can be reviewed and changed with the o 2_Design Bement
help of the Design Element tab of the Inspector window. o In % ET E,

The main (and only) parameter common to all design elements is its paper type.
It is used for printing and to display the correct dimensions of the element in the editing window.

Unlike other elements, disc design elements have more parameters to adjust:

¢ Inner and Outer Margin size
Margins are shown as a blue dotted line along outside and inside disc’s edges. They help you to keep the
appropriate spacing between objects (image or text) and the disc edge.

The margins have two purposes:

o Mark the area near the disc edge that should not be used for Margins — ]
pictures and text. Outer: (3.5  mm .

o Margins cause text wrap (if enabled). When a text box is placed mner: |35 | mm 2
very close or above a margin, text will wrap around the margin. -

E" Cause Text Wrap
* The Text Wrap option enables/disables text wrap with respect to the disc edge
and the disc hole edge.

Hole Size. You can choose between the small and large hole size. This option may Hole Size

be used for printing on plain paper or directly on discs. @ small () Large
If you have selected a supported label paper, this option will be disabled as the hole

size is predefined for this paper.
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Creating Custom Design Elements

If you want to use a non-standard design element, it is possible to create one of your own. The program lets
you create rectangular and round custom design elements.

To create a new custom design element:

@ Disc Units: | Inches |-

) Rectangle ) Circle

width: (476 [ Height: 476 | 7
Hole Diameter: | 0.00

Corner Radius: | 0.00

-
-
L)
-
-
L)

- ( Cancel ) (—.-a*-.,)

1. Click the "+" toolbar button and choose the Custom Design Element... command. The Custom Design
Element dialog will open.

2. Click the "+" button at the bottom to add a new item to the list.

3. Type in the item's name, you will be able to modify it later.

This name will be shown in the Type field on the Design Element tab of Inspector and in the pop-up list of
design elements on the toolbar.

4. Select the element’'s shape: Rectangle or Circle.
5. Select the units of measure: Millimeters or Inches.
6. Set the desired dimensions. The preview shows what you will get in the result. Click the OK button.

To remove a design element from the list, select it in the Custom Design Element dialog and click the "-"
button.

To edit the dimensions of an existing custom design element, use the Custom Design Element dialog.

For information on how to print custom design elements, see the “Printing Custom Design Elements” section
in Chapter 7.

Usually plain paper is used for printing custom design elements.
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Choosing Paper

Since specialized label paper differs in the number, position and type of printable elements (disc label, case
cover and so on), you should select the exact paper type before printing.

Use the Paper Selection dialog for this, it can be opened using one of the following:

¢ The Change Paper... button on the Design Element tab of the Inspector window;
¢ The Add toolbar button (choose Design Element From Paper... from the drop-down menu);
e The Select Paper Format button in the Print dialog.

When you select a pre-defined paper, all the dimensions and positions of the elements on the page will be set
automatically by the program.

Note: For best results the same paper type must be selected in your document and in the Print dialog.

ATTENTION! For better flexibility, the program can take paper size from the Paper Selection dialog as well as from
the system Page Setup dialog. The last selection made will be used for printing.

Normally you should select paper in the Paper Selection dialog. Use the Page Setup only if you know what paper size
must be selected!

Select the required paper for each of the design elements you are going to print on special paper (for
example, you may use one type of paper for the disc label, and another for the CD cover and tray insert).
This is not necessary for printing on plain paper. If your document has several design elements of the same
type (two discs labels, for instance), you may use the same type of paper for them. This way you will be able
to print both elements on a single sheet.

Click on the paper preview below to select a
Design Element.

{ Predefined | Custom | Recent

Manufacturer:  Avery

a3

Element: CD/DVD Label or Disc

Size: | US s

Averysses _____________§
Avery 5691L

Avery 5602

Avery 5694

Avery 5824

Avery 5931L

Avery 5981

Avery 6691L

Avery 6602

Avery 7225 CD/DVD Label 5.5x5.678
Avery 8692

Avery 8694 (8942)

Avery 8695

Avery 8696

Avery 8699

Avery 8831L
Avery 8832

"

-

Element Type: CD/DVD Label or Disc

Paper Name: Avery 5585

Search: __Customize...

-.';).- (" Cancel ) ( OK )

To select the paper for an existing design element:

1. Select the design element's icon on the toolbar so that the element is shown in the main program's
window.

Open the Paper Selection dialog: Click the Change Paper... button in Inspector.

3. Select the paper in the list to the left. To find your paper in the list, use the filters and the search tool.
The selected paper will be shown in the preview.

4. One of the elements will be selected by default in the preview. If you have selected paper with several
different elements (see Sample 2 and Sample 4 below), choose the one you want to design on. For this,
click on the element in the preview. If you're using paper as shown on Sample 1 and 3, selecting a
particular element is not necessary.

5. Apply your selection by clicking the OK button or double-click the desired design element.
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To add a new design element that corresponds to a particular type of paper:

1. Open the Paper Selection dialog: click the Add toolbar button and choose Design Element From
Paper... from the drop-down list.

2. One of the elements will be selected by default in the preview. If you have selected paper with several
elements (see Sample 2 and Sample 4 below), choose one you want to design on. For this, click on the
element in the preview. If you're using paper as shown on Sample 1 and 3, selecting a particular element
is not necessary.

3. Apply your selection by clicking the OK button or double-click the desired design element.

Note: Selecting paper in the Print dialog does not affect the document. This selection is only valid during the time of
the printing session. For details, see “The Print Dialog” section.

Sample 1 Sample 2 Sample 3 Sample 4

It is recommended that you select the paper you will print on at the very beginning, don't wait until the last
moment. Though design elements are mostly of similar shape and dimensions, they may differ slightly from
paper to paper. So, if you prepared your design for one type of paper, and use another one to print on, your
design may get offset by several millimeters in respect to the element on the sheet (if you have changed
paper just before printing) and you will have to modify your document again.

If you have not purchased paper yet, it is a good idea to review the list of paper in the Paper Selection dialog
in order to buy supported paper.
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Custom Paper Layouts

To extend the list of pre-defined paper layouts, the program allows to create custom layouts. Custom layouts

can be used to:

¢ Add a new paper layout to the existing manufacturer's layout list.

¢« Compose your own layout to print on plain paper.

Printing a custom paper layout does not differ from using a pre-defined one.

Apart from using custom paper layouts, it is possible to add elements directly onto plain paper from the
Print dialog. This method is simpler, but not so flexible. You cannot save a layout compiled in the Print

dialog for later use, unlike a custom layout.

Creating a Custom Paper Layout

1. Open the paper selection dialog by clicking the Change Paper... button on the Design Element tab of

Inspector.

2. Open the custom paper layout editor.

There are two ways to start a new layout:

o From scratch - open the Custom tab and click the Create... button.

o By editing a pre-defined layout - open the Predefined tab and click the Customize... button.

3. Edit your layout (see below for more details).

4. Click OK to save the layout.

Editing a Custom Paper Layout

Open the paper selection dialog by clicking the Change Paper... button on the Design Element tab of
Inspector. Then move to the Custom tab, select a layout from the list and click the Edit... button. The layout

editor will open.

PaperiTray Size

Mamne: | Jaweel Case Tray Insert & DISC & Spines

Paper Size: | US Latrer B ! Direct Printing
Width: 1k mm  Height: 275 mm

Design Element Source

ChFalling Rookler €0 Slim Cage Inier 0 Core

CD Spine DD Cover DV Insert

Manage Custom Elements...

Selected Elemant

Mame: CD Tray Insert
X

Position: X: 3L.9% mm
— ¥
Y: |12.00 T [

Rotate [ Remove G

(2} 7 Send layaut ta devaloper Y Print Outlines
B

(Garal )

The Paper/Tray Size section allows you to edit the layout's name, choose one of the standard paper formats

or set your own one.

If your layout is intended for printing on discs, set the Direct printing option.
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The Design Element Source box is a library of elements.

Initially the library contains pre-defined design elements. After custom elements have been created, they are
shown at the bottom of the library, under the separator.

To add, delete and edit custom design elements, click the Manage Custom Elements button.

To add a new element to custom paper, drag it from the library to the paper preview on the right.

To change the element's location, drag it with the mouse.
Alternatively, select the element in the preview and set its position in the Selected Element section.

To change the element's orientation, use the Rotate button.

To remove the selected element, click Remove or press the Delete key.

Additional Features

Although the developer constantly adds new layouts to the list of pre-defined paper, you may have paper that
still is not listed. If you have managed to create a layout for your paper and successfully printed on it, you
can share it with the developer. This will speed up adding new paper to the list.

The Send layout to developer button composes an e-mail with all necessary layout dimensions and opens it
in your mail program.

The Print Outlines button allows printing your own layout. Use this feature to check dimensions of the
created paper layout or for other purposes.
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Working with Text

Most of the text formatting tools are located on the Text tab of the Inspector window.

Some operations common for different types of objects are described in the “Common Operations on

Objects” section.

Adding, Deleting and Modifying Text

Disc Cover supports regular and circular text. The toolbar has separate
buttons for adding each of them.

Regular text box can be added using:

e The Text tool.
Select the tool, press the mouse button and draw a text box. Then release
the button.

e The Clipboard.
Choose the Edit/Paste menu command (Cmd+V) to paste the text with
default formatting.
Choose the Edit/Paste with Styles menu command (Cmd+Shift+V) to
paste text with the original text formatting.

Both commands are available from the context menu.

A
ADD  ADD
REGULAR  CIRCLE
TEXT TEXT

To add circular text, select the Circle Text tool. Then press the mouse button
when the pointer is somewhere in the document and move the mouse to resize
the imaginary circle that outlines the text. Then release the button.

The circle will have the center in the middle of the design element and will
pass through the point, selected by the mouse. After releasing the mouse
button an edit box will appear in which you can modify the text.

To delete a text box, select it and press the Delete button on the keyboard.

To modify text, double-click on it.
You can change font attributes and color of the text inside the text box by
using the system Font and Colors dialogs.

0 Text
oM®ETE
Format

Align: E ==

Text color:

Size:  eff—— -10.0-
AlA Fonts

Spacing
Between Characters: -D.D E
Between Lines: ‘0.0 :
Before Paragraph: ‘0.0 :
Inset Margin: ‘o -
List

Lists T]

Columns

Line Up Default

Select Column by Mame
Title
Curation

If the entire text box is selected, the changes you make in the dialogs will apply to the whole text. If a portion

of the text is selected, the changes will apply to the selected part only.

In Disc Cover regular text can be arranged in multiple columns. The first column is added as described
above, other columns will be linked to it. See more details in the “Linked Text Boxes and Flowing Text”

section below.
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Text Box States

Text Deselected Selected Edit Mode
box (click outside (click on text) (double-click on text)
type the text box)
Regular . J =
ot Regular Text | | | Regular Text | Regular [Text
= =
(editing cursor is visible)
Circle C; 4 +. - Gl Tem
text "-".:'-. oy
= a Sa o
a €
Jxa":;? ixa‘; (separate edit box will open)
< . <
Rotating and Resizing Text
Rotate
To rotate a text box, select it and use the Rotate slide bar or type the angle .
value into the corresponding box of the Geometry tab of Inspector. The entire 0 -
text box will be rotated. _1g0° o L80°

To resize a text box, select it and using the mouse pointer drag one of its handles on the selection border.

Text Wrapping

Text can flow around the inner and outer margins of the disc design element.

To enable text wrapping, set the Cause Text Wrap checkbox on the Design
Element tab of the Inspector window.

Alignment

E Cause Text Wrap

Format

Use the four buttons in the Format section of the Text tab of Inspector to align
text. If the entire text box is selected, the option will affect all the text. If a part
of the text is selected, only the selected paragraph will change alignment.

Text Color and Font

There are several ways to change the text color:

e Select a text box and click the Text color button on the Text tab of Inspector.

e Select a piece of text, then open the Colors panel (Cmd+Shift+C or the Color button on the toolbar) and

select a color.

To select the background color:

e Select a text box, open the Colors window (Cmd+Shift+C or the Color button on the

toolbar) and select a color.

e Select a text box, open the Fill & Shadow tab of Inspector, check the Fill checkbox and
select a color after clicking the Color button.

Align:

Margins
Outer: 3.5 mm
Inner: 3.5 mm

Fill

If you need to add a color frame around text, select the text box, then open the Fill & Shadow tab in

Inspector and check the Line checkbox, then select a color.

Shadow

To add a shadow, set the Shadow checkbox and set the shadow color. The distance to the object, shadow
angle and blur can be also adjusted with the help of the respective controls.
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To change the text font, use the Font panel. It can be opened using:
¢ The Window/Fonts menu;
e The Fonts toolbar button;

* The Fonts button on the Text tab of Inspector.

Spacing

You can change the default spacing value of a text block to the one you need in the Spacing section on the
Text tab of Inspector.

Between Characters - the spacing between characters; can be applied to the whole selected text box, to the
selected part of text or to a single word.

Between Lines - the spacing between lines; can be applied to the whole selected text box or to the selected
part of text.

Before Paragraph - the spacing before the selected paragraph.

Inset Margin lets you control the spacing between the text and text box borders.

Inset Margin 1

et Margin lets you control the
space  between texnt and pext
block barder

ncreasing  this  walue,  vou
ncrease the space o1 all sicles
nop, botem, left and mght.

Imsut Margin 10
Margin et
cantral the s b

ol

Increxs

ssles: top, botram, kft ansd
right.

By increasing this value, you increase the distance between the text and its border from all sides: top,

bottom, left and right.

Lists

To create a list, select a piece of text or the entire text box. Open the Text tab of Inspector and select the

bullet type from the Lists drop-down list.

Linked Text Boxes and Flowing Text

Sometimes text needs more space than a text box provides. Some
part of the text goes beyond the borders of the text box and becomes
invisible. The text box border indicates this with a red plus symbol
inside a rectangle. To make all of the text visible, you can extend the
text box using the selection handles on its sides and corners. Also you
can create a linked text box. The text which doesn't fit in the first text
box will flow into the linked one. The border of a linked text box
indicates that the text begins or continues in another text box.

Text in linked boxes flows between the boxes. This means that when =
you add a new linked box, text flows into it taking up the necessary
space (if needed). When you resize one of the existing text boxes,

the text flows from the box into the following one if you reduce the

size or back into it in case you increase its size.

Linked text boxes are a powerful tool for creating multi-column text. =
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You can add a linked box (new text column) before the first box and after the last one.
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To add a box before the first one, click on a white square at the left side border of the first box and draw a
rectangle where a new box will be placed. The text from the original box will flow into the new box to fill it,
and only the part that doesn't fit will remain.

h new box will be
linked to this one.
Click on the sguare
Bn the right side of 7
its border and draw

another text box.
= o} - |

—

To add a box after the last one, click on a white square at the right side border of the last box and draw a
rectangle where a new box will be placed. The text from the original box will flow into the new box only if it
doesn't fit in the original box.

A new box will be

lnked to this one.

Click on the square

Bn the left side of ils?
baorder and draw

another text box. 4

o o o

During the design process text borders may change their appearance but always remain visible. The borders
can be hidden by choosing Hide Object Borders from the View menu. To make them visible, use the
View/Show Object Borders menu item. When text is selected its text box borders are always shown.

Working with Columns

The program has special commands in the Inspector window (in the Columns section on the Text tab) to
work with text columns when tab stops are used as the column delimiter.

Use the Line Up button to form accurate columns.
The Default button cancels the results of the Line Up formatting.

Note: To make the "Line Up" command work properly, extend the width of the text box so that the text fits completely
and lines do not break.

Selecting a single column

To select an individual column in a text block, on the Text tab of Inspector select the column name in the
Select Column by Name list at the bottom of the tab. The column with this name will be selected. This may
be useful when you need to apply formatting to the entire column.

Note: The command works only for text taken from the Source panel.
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Check Spelling

You can check the spelling of text in Disc Cover. Spelling can be checked for the entire text box or for a part
of text.

To check spelling for the entire text box, double-click on it to enter the text edit mode and select
Edit/Spelling/Spelling from the menu. If your text has spelling errors, the program will highlight the first
one. Misspelled words will be underlined with a red dotted line. The Spelling window will show the possible
options for that word and you will be able to correct or ignore it. Click Next to find the next misspelled word.

At the bottom of the Spelling window there is a list of available languages. The program uses the system
spell checker, so the dictionaries available will be those installed in your system.

If you want to check spelling for a part of text, select that part of text and run the spelling check.

You can check spelling without the Spelling window. Select Edit/Spelling/Check Spelling from the menu or
press Cmd+";". Every time you do this, the next misspelled word will be shown.

To have the program underline misspelled words at the same time as you type, select Edit/Spelling/Check
Spelling As You Type from the menu.

Finding and Replacing Text

The program lets you find and replace a word, number or some character set in a text box.

Double-click on a text box to enter the text editing mode and select Edit/Find/Find from the menu. Enter a
word you are looking for in the Find text box and click Next.

If you need to replace a word, enter the new word in the Replace text box and click Next and Replace.
Edit/Find/Find Next will find the next occurrence, Edit/Find/Find Previous - the previous one.

Select a word and choose Edit/Find/Use Selection for Find and the selected word will be the criterion for
search.

If you have selected a part of text, the option Jump to Selection will scroll the page (if needed) to make the
selection visible.
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Working with Images and Smart Shapes &G EE
=] =

The program allows using images from different sources:

™
1. Images supplied with the program (clipart). El Q) . =n.
2. Images imported from graphic files. Flara .-]
3. Pictures from your iPhoto library. Dandelion 1., Flower Purple
4. Images downloaded from the Internet. The program uses the Google

image search engine.

The internal image collection contains a separate collection of vector images
- Smart Shapes.

The Clipart tab has several subsections.

MDD -
] |

1) (2) (3) (1) (5)
\VACIARIACIAC),

Flowers Apple

1. Internal collection of images Flowers Pink  Flowers White +

2. Internal collection of Smart Shapes Search: Q-
3. Custom Folder

4. Image Depot

5. Collage templates

Some operations common for different objects are described in the “Common Operations on Objects”
section.

Adding an Image

To insert an image supplied with the program:

1. Open the Clipart Collection tab on the Source panel or select the Window/Clipart Collection menu item.
2. Select an image category in the drop-down list.

3. Drag the desired picture to the document.

To insert an image from the iPhoto library:

1. Open the iPhoto tab on the Source panel or select the Window/Import/Photo menu. Then click the
Photos button.

2. The thumbnails of your photos will be displayed on the tab. This may take some time if your iPhoto
library contains many pictures.

3. Drag a picture from the Photos tab to the document, or click on it to have it inserted into the center of
the document.

To insert an image from a file on the disk:
1. Choose the File/Insert Image menu, or click the Insert Picture button on the toolbar.

2. In the Open dialog, navigate to the graphic file you want to open and click the Open button. Images in
JPEG, PDF, EPS, GIF, PNG, TIFF and some other formats are supported.

3. The image will be inserted into the center of the document.
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If you need to insert multiple images from a single folder, open the Clipart tab on the Source panel and click
the "folder" icon or select the Window/Clipart/Custom Folder menu item. You can also use the Folder button
on the Photos tab of the Source panel.

By default, the program shows images included into the selected folder only. In this mode, the pop-up list at
the top of the Clipart panel lets you access content of subfolders. To preview images from all subfolders,
enable the Get Images from Subfolders option in the Browse window. Note, that Clipart may show images
with some delay depending on how many images are in the folder.

To find and download an image from the Internet:
1. Choose the File/Search Images in Internet menu command.

2. In the dialog, type the keywords that describe the image you need and click OK. Disc Cover uses the
Google image search engine.

3. The found images will be displayed on the Clipart Collection tab as they are downloaded.

If Image Tricks (www.belightsoft.com/imagetricks) was installed on your computer, you can use its generator
plug-in to create images for the document's background. Without the Image Tricks plug-in the internal image
generator will be used.

To add a generated image:
1. Open the Clipart tab on the Source panel and move to generators (Image Depot tab of the Clipart).
2. Click the Generate button. The generators' dialog will come up.

3. Select a generator from the list, modify its parameters if needed and click the OK button. The generated
image will be added to the document.

To add an image without adjusting its parameters, choose a generator from the Insert/Image/Generate
Random menu.

You can store generated images in the internal clipart.
To add a generated image into the clipart, select it in the document and click the Add button.

More details on generators can be found in Image Tricks documentation.

Internal Image Storage

Images you work with can be put into the internal image storage (Image Depot tab). It can be used to save
images you have generated. You can also collect images from different sources into a single place to access
them later quickly.

To add an image into the clipart, select it in the document and click the "Plus" button ( + ). The image will
be saved on your disc.

To open the folder containing your image storage, click the "wheel" button ( 1 ). Use this to remove or
rename images.
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Image Attributes

@

Image

On the Image tab of the Inspector window you can set the tint color L = (= |D
for an image. Click the Color button to select a color. L | % _:_:' T -

To change transparency of an image, use the Opacity slider.

The Tile Image tool creates multiple down-scaled copies of the image = i |r!'|a.;|+: 5
in the rectangle that the image takes. This feature can be used for — Mask image

decorating your designs. - = - = |a
To tile an image, select it and choose Format/Image/Tile in the EI
menu or tick Tile in Inspector. Use the Tile slide bar to adjust the -

number of tiles and their size.

Images have a special attribute related to import. If Set Image as
Replaceable is enabled in the Format/Image menu, the image will be
replaced with an imported one. The program will preserve the size
and position of the original image. If the new image has different
proportions, it may be cropped.

I

Mask Image yp
nteresti - . L e -
To apply some interesting effects to your images, use the Mask
Image option from the Image tab of Inspector.
Select an image, check the Mask Image checkbox and select a mask
from the collection on the Image tab.
If you want to use your own picture as a mask click the Browse - S e
button and select an image file. Or simply drag an image into the Dpacity: _
mask preview box located to the left from the Browse button. — =
P e—— ] Tile
Edit.

MASKED

Crop Image

From time to time you may need to use part of an image. For instance, you have a photo, part of which you
want to use in your design. To cut out a piece of the image, use the Crop Image tool. To apply it, select an
image and click the Edit button on the Image tab of Inspector or simply double-click on the image. The Edit
Image window will come up. Set the appropriate scale and then select the region to crop and click OK. The
selected part of image will appear on your document.

Note: If you're working on Mac OS 10.4 or later and have installed the Image Tricks application for working with Core
Image filters, make sure that the Crop tool is selected in the Edit Image window.

Core Image filters

The Core Image filters are available for users of Mac OS 10.4 and later (you'll need to install Image Tricks
before use). To start working with filters, double-click on an image.

Installed filters are listed in the Edit Image window. The filters are organized in categories (color, blur, etc.).
Some filters have adjustable parameters. If such a filter is selected, the corresponding controls will be
enabled at the bottom of the window: slide bars and the Color button (which opens the Colors panel).

The picture in the preview area immediately changes after selecting a filter or if you change parameters of
the selected filter. Every time you select a new filter, you'll see the result applied to the original picture.
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Some filters have an additional parameter. Effects that have such a
parameter allow you to edit images with a mouse click directly on
the image. The mouse click will be the base of distortion or other
effect. When you move the mouse pointer on the image with the
button pressed (the left button for a 2-button mouse), the image
changes in real time (the reaction depends on the performance of
your computer and of your graphics card).

The filters for which you can select such a point are marked in the
filter list by the crosshair icon on the right. When such a filter is
selected, the mouse pointer also looks like the crosshair.

Filters of another type are marked with a "colored ball" icon. This
means that such a filter has color as a parameter. Selecting such a
filter will enable the Color button.

Changing the Image Size
To change the image size, click the Size button.

You can set image size in pixels or as a percentage from the
original size.

To avoid image deformation, set the Fix Proportion checkbox.

LIST OF
EFFECTS

EFFECT
PARAMETERS

E Filters | Generatars
EHtects ; :
Crop [k
Color Cantrols !

Exposure Adjust

Camma Adjust

Hue Adjust

White Point Adjust L1
Color Monochrome L4
Color Posterize

Color Invert

Transparent

Unsharp Mask
Gaussian Blur

Motion Blur +
Eaturation: " .=
—_— 150 -
Erightness: P

0.00 3
Contrast: . -
ey {130 (3

To access the Core Image filters via the Edit Image window, install the free Image Tricks application. More
information related to Core Image filters can be found on the Image Tricks Web page:

http://www.belightsoft.com/imagetricks
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Working with Smart Shapes

Smart Shapes are vector images that can be used to decorate your
document or for other purposes.

@,
[
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m
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To add a shape, open the Smart Shapes tab on the Clipart Collection
using the Window/Smart Shapes menu command. Drag and drop a shape
on the design or click on it.

Smart Shapes behave mostly like ordinary images. In addition to the
operations applicable to images, some Smart Shapes have one or two
adjustable attributes.

1 e
iz

Operations on shapes are available from the Inspector window. Open it
using the Inspector button on the toolbar or through the Arrow Two-way Ar...
Window/Inspector menu.

The main attributes of Smart Shapes are Border Line and Filling. You can
modify them on the Fill & Shadow tab of Inspector.

O
©

The most common operations are described in the “Common Operations

on Objects” section below. Circle Donut

Special Attributes

A
S

To some shapes the Curve and Side Count options (from the Geometry
tab of Inspector) can be applied.

Smart Shape

Curve:

Side Count:

ik
L

For example, the 5-point Star can change number of rays by means of the Side Count control and the angle
of rays by means of the Curve control.

In addition to Smart Shapes, the Clipart collection contains a collection of Basic Shapes: circles, rectangles,
arrows and other. They are PDF vector images (that is, they don't have the special attributes of smart
shapes). To find them, open the Clipart Collection tab of the Clipart panel (menu Window/Clipart
Collection) and select Basic Shapes in the drop-down list.
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Filling Smart Shapes with Images

Smart Shapes can have a transparent body or can be filled with a solid color or with an image. These options
are located on the Fill & Shadow tab of the Inspector window.

The image used to fill the Smart Shape is shown in the Fill & Shadow section of Inspector. The image
inserted into the Smart Shape looks as if it was cropped to the form of the Smart Shape.
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To fill a Smart Shape with an image:

1. Open the Fill & Shadow tab in Inspector (menu: Window/Inspector/Fill & Shadow). All necessary
controls are there.

2. Select the Smart Shape in your design. Switch from Color Fill to Image Fill in the drop-down list.

Drag the image into the image box in Inspector.
To select an image from a graphic file, click the Browse button.

If your image is in Clipart or was imported and is shown now on the Source panel, select the Smart Shape
and click on the image.

Scale options affect how the image will be modified when inserted into the Smart Shape.

¢ Filled - does not change the aspect ratio of the image. A part of the image may not be seen in the Smart
Shape.

¢ Fitted - the whole image gets into the Smart Shape, the image may be deformed.

¢ Stretched - the whole image gets into the Smart Shape, the image sides proportion will not change.
Blank space may be left inside the Smart Shape.

e Tiled - does not change the aspect ratio of the image. If the Smart Shape is not big enough, the image
will be partially cut off. If the Smart Shape is bigger than the image, it will be filled with multiple copies
of the image.
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Common Operations on Objects

The operations listed below are common for different object types: text, images and Smart Shapes.

Most operations on objects can be performed using tools from the Inspector window or the program menu.
Some of them - by using the context menu.

Moving Objects
Move objects with the mouse by dragging them.

For precise movement, select an object and use the arrow keys on the keyboard. For faster movement press
Shift+[Arrow key].

On the Geometry tab you can enter the coordinates of an object to place it exactly where it is needed on the
page. The units of measure can be changed in the program's preferences.

When you move an object with the mouse, it snaps automatically to another object's edge. You may toggle
the Snap function on or off if you hold down the Cmd key as you move the object. To turn it off permanently,
use the Preferences dialog. When an object is moved smart guides are displayed automatically to position
objects more accurately.

SMART GUIDE
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The commands Move to Center (Horizontally) and Move to Center (Vertically) from the Format menu move
the selected objects to the page center along the horizontal or vertical axis.

Size and Orientation

The size of an object can be changed using the mouse: Select the object and drag one of the handles on its
border. To resize an object preserving its aspect ratio, use the corner resize handles. Side handles resize
that particular side only. To inverse the action of corner handles, hold the Shift key down.

On the Geometry tab you can enter the dimensions of the object to make it exactly the same size as needed.
The units of measure can be changed in the program's preferences.

When you set a new size and Fix aspect ratio is checked, the proportion between the sides will be preserved.

If an image size was increased or decreased, you can always restore the original size using Original Size
button.

For a selected object you can set the rotation angle in the Rotate section, and use vertical or horizontal
flipping. Text cannot be flipped.

Several images can be resized and rotated together. When you resize a group of selected images, it behaves
as a single image. When you rotate a group of images, they move around the center of the selection.

Border Line, Filling and Shadow

Border lines can be made visible/invisible by using the Line checkbox on the Fill & Shadow tab of Inspector.
Use the Color button to open the standard Colors panel to change line color and opacity.
Adjust the thickness of the line using the Thickness slide bar.

You can tint (fill) an object using the Fill checkbox on the Fill & Shadow tab of Inspector or using Tint image
on the Image tab.

Use the Color button to open the standard Colors panel to change tint (fill) color.

Adjust the opacity of the tint using the Opacity slider.

The result of Tint depends on the object it was applied to.
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Images look like they are tinted when Opacity is about 20-70%,. If Opacity is more than 95%, the image can
be considered as filled. This is used mostly for Smart Shapes and Basic Shapes.

TINTED IMAGES

$) (8

OPACITY 703 OPACITY 100%

If you select text and check Fill with some color, the background of the text will be of that color.

If Shadow is checked on the Fill & Shadow tab of Inspector, a shadow of the selected color will appear for
the selected object. The distance between the object and the shadow, its angle and blur can be also adjusted
with the help of the respective controls. To change the color and opacity of the shadow, open the Colors
panel by clicking on the Color button in the Shadow section.

A shadow can also be added to text (to the letters), if you select a portion of text or a text box and apply the
shadow as described above.

To set the same border line, filling or shadow attributes for several objects, apply the settings to a group of
selected objects.

Objects Alignment

The Alignment tab of Inspector has several options for aligning objects. Select two or more objects and click
one of the alignment buttons. You can align Left Edges, Right Edges, Top Edges and Bottom Edges. You can
also align the centers of the objects vertically or horizontally.

If you need to align several objects, select them first. Open the Alignment tab of Inspector and select the
kind of alignment you need. The same commands you can find in the menu: Format/Align.

Distribute Objects

The commands from the Format/Distribute menu and the Distribute section of the Alignment tab of
Inspector affect how the selected objects are distributed on a page. These commands are used to create
equal spacing between objects, and can only be used for three or more objects.

e Distribute/Spacing Horizontally creates equal horizontal spacing between the edges of the objects.
* Distribute/Spacing Vertically creates equal vertical spacing between the edges of the objects.
* Distribute/Centers Horizontally creates equal horizontal spacing between the centers of the objects.

* Distribute/Centers Vertically creates equal vertical spacing between the centers of the objects.

Circular Distribution

Objects can also be distributed in a radial or circular way. The respective buttons are located in the Circular
section of the Alignment tab. These operations require at least 2 objects.

The left button distributes the objects to create equal angles between imaginary lines passing through the
centers of the objects and originating in a common center. The distances from the objects to the center will
be arbitrary and depend on their original position.

©

Red lines ara shown only for your reference
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The right button places the centers of the object on an imaginary circle. The distances between the objects
may be different and depend on their original position.

'\\..\.

°®

“ »

Red circle is shown only for your reference

If you apply both commands one after another, the objects will be placed on an imaginary circle and the
distances between them will be equal.

Red lines are shown anly for your reference

Changing the Display Order of Objects

Use the Bring Forward, Bring to Front, Send Backward, Send to Back commands from the Format menu to
change the display order of objects.

When you create objects, each subsequent object is located one level higher. That is, when you move one
object over another one, the one which is higher will cover the "lower" object. These commands help to
change the order in which objects are displayed.

e Bring Forward places the selected object one level higher.
e Bring to Front places the selected object above others.
* Send Backward places the selected object one level lower.
* Send to Back places the selected object below others.

Sometimes you may need to place one object behind another. This is especially convenient when you use an
image as a background. Use the Send Backward/Bring Forward commands from the Format menu for this
purpose. The Send Backward command puts the selected object behind all other objects. The Bring Forward
command places it in front of all other objects.

The commands Move To Background and Move To Foreground from the Format menu move the selected
object to another layer.
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In some cases you may need to select an object that is fully covered by another one and can't be seen. For

instance, to resize or move an image used as the background for text. The easiest way to access lower
objects is using the throughout selection.

Click several times on the pile of objects holding down the Cmd key. Each time you click, the object on the

next lower level will be selected. If the upper object is not transparent (is a picture, for instance), you will see
only the selection border of lower objects.

Keep the Cmd key pressed to bring up the context menu for lower objects.

If you need to bring a lower object to the front, select it as described above and choose the Format/Bring to
Front menu command.
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Making Collages

particular order (even if they look to be placed at random). Once a proper size
and location for each image are found, you may want to use the design with new
images instead of existing ones.

When creating a design with a picture collage, you usually assemble images in a _@
bd

The technology introduced in Disc Cover allows you to use saved collage EEE | EEsD
templates with new images. Collages are based on filling Smart Shapes with B Ff:;%g
images. Images from the Smart Shape collection are used as placeholders (image EmEE “;dEI_
frames) in the design. In addition, they vary the shape of image boundaries. - e
The program is supplied with collage design templates. ,:9_ v e
§ = o
To mak llage f template: e
0 make a collage from a template L i, ﬁi& .
1. Open the Collage panel (menu: Window/Clipart/Collage). — o
2. Click on a collage template or drag it into your design. . TH
3. Select an image placeholder and drag a new image inside it from the Clipart Q"@j Qﬁj
or Source panel. To insert an image from a graphic file, select it via the G | =3
Browse button from the Fill & Shadow tab of Inspector. LB ie
4. Repeat this with other images. | % BN
p g ;;;g E%..‘s.
Ela | &8 L

If needed, adjust the way the image fills its frame (use Scale options).

To make a collage from scratch:

1.
2.
3.

Open the Smart Shape collection in Clipart (menu: Window/Clipart/Smart Shapes).
Open the Fill & Shadow tab of the Inspector window (menu: Window/Inspector/Fill & Shadow).

Add several Smart Shapes into your design. Select them, set the Fill option. Click the Color Fill drop-
down list and select Image Fill.

Fill Smart Shapes with images: select a frame and drag an image inside it.

If you want to make images replaceable at a later import, select them, go to the Format/Image menu
and click Replace image at import.
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Chapter 6
Importing Disc Content

Disc Cover can automatically create a list of the content of the disc (files, music, etc) to be used in your
design. The program offers different options depending on the type of data on the disc.

Music Disc Content (iTunes, MP3 files, Toast)

Disc Cover can import a list of audio tracks from iTunes if you use it to organize and play back your music.
You can also create a track list if your audio collection is stored as MP3 files on your hard disk.

Importing a Track List from iTunes

1. Open the Music tab on the Source panel (use the Window/Import/Music menu command). Choose
iTunes in the Import Data From pop-up menu to open the Import dialog.

Select a playlist in the left box and its tracks will be shown in the right box.
Select tracks you want to import and click the Import button.

The list of imported tracks will appear on the Source panel. Select a presentation format of the list and
drag it to your document.

Note: If you drag text from the Source panel onto existing text, the new text will replace the old one. A blue frame
indicates that text in the text box will be replaced.

If the Automatically replace Text in Objects with imported data checkbox is enabled inthe Import dialog,
the program will update data in your document automatically.

Creating a Track List of your MP3 Collection

1. Open the Music tab on the Source panel (use the Window/Import/Music menu command). Choose MP3
Files in the Import Data From pop-up menu to open the Import dialog.

2. Click the Change Folder button to select a folder with your MP3 collection. The right box will show the
name of the selected folder and the audio tracks will be shown in the left box.

Select the tracks you want to import and click the Import button.

A list of imported tracks will appear on the Source panel. Select a presentation format (one column, two
columns, etc.) of the list and drag it to your document.

Note: If you drag text from the Source panel onto existing text, the new text will replace the old one. A blue frame
indicates that text in the text box will be replaced.

If the Automatically replace Text in Objects with imported data checkbox is enabled in the Import dialog,
the program will update data in your document automatically.

Your MP3 music collection may contain pictures (album artwork). If so, they will be shown on the Source
panel below the track list. You can drag them to your design.
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Importing from a Toast Titanium Audio Project

Disc Cover can import data from a Toast audio project: track name, track duration and playlist name (Audio
CD name).

1. Open the Music tab on the Source panel (use the Window/Import/Music menu command). Choose
Toast in the Import Data From pop-up menu to open the Import dialog.

Select a Toast project.

A list of imported tracks will appear on the Source panel. Select a presentation format (one column, two
columns, etc.) of the list and drag it to your document.

Note: If you drag text from the Source panel onto existing text, the new text will replace the old one. A blue frame
indicates that text in the text box will be replaced.
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Photo Album Content (iPhoto, Finder)

Disc Cover can access your photo collection. You will be able to use the images and a list of image names for
your design. Images can be taken from iPhoto, a folder on your hard disk or a removable storage device.

To access images from iPhoto or any folder, open the Photos tab on the Source panel (use the
Window/Import/Photo menu command).

Opening Images from iPhoto

Open the drop-down list in the middle of the Source panel and select Library to import the whole library or
one of the albums.

To pick up individual images from iPhoto and display them on the Source panel:
1. Click the iPhoto button to open the Import dialog.

2. The left box will show albums from iPhoto. Select one or more albums (use the Cmd or Shift buttons for
multiple selection). Photos from the selected album will be shown to the right.

3. Select the images you want to import and click the Import button.

The Source panel will show thumbnails of the selected images and a list of their names. You can drag images
and the list of image names to your document. If necessary, change the list format in the Format drop-down
list.

To replace an existing image with a new one, select the image in your document and click on the new image
on the Source panel.

You may use the images on your design as placeholders, which will be automatically replaced with the new
images you import. The images will be cropped to the size of the placeholder images.

To turn an image into a placeholder:

1. Select an image (or several images) and enable the Replace Image at Import option in the
Format/Image menu.

2. When you import new images using the Import dialog, enable the Automatically replace Text in Objects
with imported data option.

3. Click the Import button. The images on your design will be replaced with those you have selected in the
import dialog. They will be cropped to accommodate the size of the placeholder images.

Opening Images from a Folder

Click the Folder button to select a folder containing images. The Source panel will show image thumbnails
and a list of file names.

To use images or the list of names in your document, drag them to the document.

You may use the images on your design as placeholders, which will be automatically replaced with the new
images you import. The images will be cropped to the size of the placeholder images. See the procedure
described above.

Note: If you drag text from the Source panel onto existing text, the new text will replace the old one. A blue frame
indicates that text in the text box will be replaced.

If the Automatically replace Text in Objects with imported data checkbox is enabled inthe Import dialog,
the program will update data in your document automatically.
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Video Disc Content (iDVD)

Disc Cover can import data from iDVD projects. These can be photo thumbnails included in slide show or
movie frames used for motion menus. Disc Cover can also import the names of DVD menu items.

Importing from an iDVD Project

1. Open the Video tab on the Source panel (use the Window/Import/Video menu command). Click the
iDVD Project button and select a project document.

2. Menu item names, photo thumbnails and video clips will appear on the Source panel. Drag images
and/or text block to your document.

Note: If you drag text from the Source panel onto existing text, the new text will replace the old one. A blue frame
indicates that text in the text box will be replaced.

If the Automatically replace Text in Objects with imported data checkbox is enabled in the Import dialog,
the program will update data in your document automatically.
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File List

Disc Cover allows you to create and print a list of files and folders from a folder on your hard disk or
removable disk.

1. Open the Data and Files tab on the Source panel using the Window/Import/File&Folder List menu
command.

2. Click the Folder... button to open the File Import dialog.

In the dialog, navigate to the desired folder. The name of the selected folder will be shown in the left box
as the root folder. You can navigate its subfolders, if they exist.

The right box will show list of files and folders from the folder(s) selected on the left. The shown files and
folders are in the folder hierarchy one level below the folder(s) selected on the left. You can select
several folders to add their content to the list on the right (use the Cmd and Shift buttons for multiple
selection).

All file and folder names you want to import must be selected in the right list.

To change the root folder, click the Change Folder... button and select the desired folder.

3. If the Automatically replace Text in Objects with imported data checkbox is enabled in the Import
dialog, the program will update data in your document automatically.

When ready, click the Import button. The selected files will appear on the Source panel.

4. Drag the list to the document. Use the Format drop-down list from the Source panel to control the list's
format.

Note: To get a list of folder names, select "Folders" in the Format drop-down list.

Note: If you drag text from the Source panel onto the existing text, the new text will replace the old one. A blue frame
indicates that text in the text box will be replaced.

BeLight Software, Ltd www.belightsoft.com File List 60



Disc Cover User’s Manual Importing Disc Content

Importing Data from a Text File

Disc Cover can import files with textual data created in other applications. Such text file may contain a list of
files, audio tracks or other information.

To separate blocks of data, delimiters are used. Disc Cover supports tab stops, commas and semicolons as
delimiters.

To import data from a tab-, comma- or semicolon-delimited file:

1. Open the Data and Files tab on the Source panel using the Window/Import/File&Folder List menu
command.

Click the File... button. The File Import dialog will open.
Click the Change File... button and select file to import.

The program will define the data field delimiter automatically, and show data.

If the data is shown incorrectly, try to change Encoding and Delimiter using the respective lists at the
top of dialog.

Select all the lines you want to be shown in the list.

If the Automatically replace Text in Objects with imported data checkbox is enabled, the program will
update data in your document automatically.

When ready, click the Import button. The selected files will appear on the Source panel.

4. Drag the text block into the document. To control its format, use the Format drop-down list from the
Source panel. To create a custom format, choose the Other... option at the bottom of the Format list
(see the “Custom List Formats” section below for details).

Note: If you drag text from the Source panel onto existing text, the new text will replace the old one. A blue frame will
indicate that text in the text box will be replaced.
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Custom List Formats

Imported text is usually formatted in columns. The purpose of formats is to specify the data that will be
imported and choose the way it will be presented in the document. Several most common formats can be
chosen from the Format drop-down list. Clicking the Other... item opens a dialog for editing custom formats.

Number—Title-Album To create Import Format drag Field Names from the table

to Output Line.

Num | Fiald Name

1 Number -
2 Playlist ﬂ
3 Title

4 Artist

5 Album H

Add Field

Name: Number-Title-Album

_! Extlude repeating values

Line Delimitar: = Reburn = !

Qutput Line format:

Kumoer Title Album

[+[]
@

. Cancel ) ( Ok ;

The dialog shows the list of custom formats to the left and the settings of the selected format to the right. To
add and remove formats from the list, use the "+" and "-" buttons.

Creating a Custom Format

1.
2.

5.

Click the "+" button to add a new format. Type its name in.

Add data fields to the Output Line Format edit box. You can select a field and click the Add Field button
or drag a field from the list into the edit box.
Fields will be added one after another. You can separate them with spaces, tab stops or other symbols.

Choose the line delimiter - the symbol that will separate data field groups. One group is that what you
see in the Output Line Format edit box. A commonly used delimiter is "Return”.

Select or deselect the Exclude Repeating Values checkbox. When the option is enabled, the program will
import only one line if data has several completely equal lines.

Click OK to apply the changes.

Custom formats are listed under pre-defined formats in the Format drop-down list on the Source panel.
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Chapter 7
Printing

With Disc Cover you can print your designs on special label paper, on standard plain paper, on custom paper
(using a custom paper layout) or directly to a CD/DVD.

Printing on Pre-Defined and Custom Paper

It is likely that you will design a document to print it on special label paper. The best result will be achieved if
you calibrate the printer and select the paper you will use prior to printing. As this is very important, both
operations can be performed from the Print dialog with the help of the Calibration and Select Paper Format
buttons (see the “Printer Calibration” section for details).

On how to create a custom paper layout, see “Custom Paper Layout” in Chapter 5.
To print your document:

1. Open the design element you want to print in the editing window (by using the small icons just below the
main toolbar) and click the Print button on the toolbar (menu File/Print...).

2. The Print dialog will open showing your design element on the selected paper. All design elements in
your document (if any) will be displayed in the left box. You can organize design elements on the paper if
your document has several design elements.

3. Make the necessary settings:

o Select paper in the Paper drop-down list.
If you don't see the needed paper in the list, click the Select Paper Format button to open the
Paper Selection dialog (the full paper list). The paper selected in the Print dialog will be used
only in the current print session and will not be saved for the future.

For direct-to-CD printing, you should select CD-R Tray in the Size list, and then your printer
model. See "Printing Directly to a Disc" for more details.

o Enable or disable printing of cut lines and dotted marks (they are helpful for printing on plain
paper). Adjust the bleed width if needed.

o Enable or disable the raster printing mode. Raster printing may solve some printing problems,
though printing will take more time.

o Calibrate the printer (see the “Printer Calibration” section for details).
4. Click the Next button to open the system print dialog.
5. Set the printer settings if needed and click the Print button.

Designing and printing custom elements differs from working with standard elements and is described
separately. See “Creating Custom Design Elements” in Chapter 5 and “Printing Custom Design Elements”
further in this chapter.

ATTENTION! Paper size can be selected from the Paper Selection dialog as well as from the system’s Page Setup
dialog. The latest selection will be shown in the preview and used for printing.

Normally you should select paper in the Paper Selection dialog.

For example, if after selecting a Letter-sized Avery paper, you set a 6x4 in paper in the Page Setup dialog, your
design will be cut down to the 6x4 inch size. In this case you should re-select your Avery paper in the Paper Selection
dialog.
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Organizing Design Elements on Paper
All design elements of your document are shown at the left part of the Print dialog.
You can add or remove elements from the paper sheet in the preview.

1. Adding design elements to the sheet

Drag a design element icon from the left box onto the paper sheet and drop when the "plus" mark
appears.

2. Removing a design element from the sheet
To remove your design element, drag it outside the element's bound on the sheet in the preview.
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Printing on Plain Paper

1. Open the Print dialog (menu File/Print...).

2. Select plain paper in the Paper drop-down list: A4 Plain or US Plain.
If label paper was used, the program would have to fit the custom element into a pre-defined placeholder
and your element might get resized.

3. Compose your layout.
To add an element, drag it onto paper.

To replace an element, drag another element over the existing one.
Note: There must be enough space on the paper. If the new element is bigger than the old one, there may be not
enough space for it.

To remove an existing element from paper, drag it out of its bound on the sheet.
4. To continue, click the Next button.

You cannot save the created layout for the future. To be able to save your layouts or to get more flexibility in
editing custom paper, create a custom paper layout (see “Custom Paper Layout” in Chapter 5).
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Printing Custom Design Elements

Usually, plain paper is used for printing custom design elements.

1. Open the Print dialog (Cmd+P).
2. Select plain paper in the Paper drop-down list: "A4 Plain" or "US Plain".

In the case of using standard paper, the program will have to fit the custom element into a pre-defined
placeholder and your element may get resized.

3. Drag your design element from the box to the left onto the paper sheet in the preview area.

If there is enough space left, you can drag one more element to the free area on the paper. The program will
distribute elements on the sheet automatically. When there is no free space, you can replace elements or
remove them from the page.

To replace an element, drag another element over the existing one.
Note: There must be enough space on the paper if the new element is bigger.

To remove an existing element from paper, drag it out of its element on the sheet.

4. Click the Next button to open the system print dialog.
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Printing Directly on a Disc

You can print directly to a CD/DVD, if this feature is supported by your printer (and if Disc Cover supports
your printer).

To print to a CD/DVD:
1. Open your disc design.

2. Select your printer (CD Tray) in the paper selection dialog for the disc design you want to print.
For this, open the Inspector window (menu: Window/Inspector/Design Element) and click the Change
Paper button on the Design Element tab. Find your printer in the Manufacturer drop-down list.

Open the print dialog (menu: File/Print).

Change the bleeds width if needed. Do not change paper here, the disc tray is already selected! Click the
Next button.

5. When the system print dialog is open, make sure the correct printer is selected.
Now you should tell the printer you are going to print on a disc.

Epson printers: open the Copies & Pages drop-down list, select Print Settings and set Media Type to
CD/DVD.
For more information refer the User's Manual of your printer.

Canon printers: open the Copies & Pages drop-down list, select Quality & Media and set Media Type to
Printable disc.
For more information refer the User's Manual of your printer.

If you encounter problems with printing directly on a CD or DVD (the printer driver shows a message about
an improper media type), select the paper format, recommended by the printer manufacturer. This solves a
printing problem with some printers (such as Epson R800).

In this case, follow the steps above. After the 2" step open the Page Setup dialog (menu: File/Page Setup)
and select A4 (or US Letter) in the Paper Size drop-down list.
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Printer Calibration

Printer calibration is used to configure your printer so that it prints accurately on special paper. It helps to
avoid unwanted offset of the printed picture with respect to the paper layout.

To calibrate your printer:
1. Choose Calibrate Printer... from the File menu to display the Printer Calibration dialog.

2. Select the paper you are going to print on in the Paper drop-down list (e.g. Avery 5558). If you cannot
find the paper you need, click the Select Paper Format button to get the full list of supported paper, and
find the one you have there.

Select the printer if you have several printers installed on the system.
Click the Restore Defaults button to reset the initial values.
Insert a sheet of your paper into the printer.

Click the Print Calibration Sheet button and then click the Print button in the system print window.

N o o s~ w

Move the calibration picture in the preview using the mouse so that the preview looks exactly like the
calibration sheet that has just been printed. You can also enter the offset into the edit boxes or use the
stepper arrows to set the precise offset values.

To make sure you have calibrated your printer successfully, print a test copy of your label or cover.

Note: Entering correction values does not affect the calibration rulers on the calibration sheet. They always show the
real offset values, even after calibration.
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APPENDIX A
The Preferences Dialog

Disc Cover has settings, which are applied by default every time you run the application. By changing them
in the Preferences dialog you can control the program behavior. To open the Preferences dialog, choose the

Disc Cover/Preferences menu item or press Cmd+",
This dialog controls application-wide settings.

Open Assistant on Start-Up - here you can specify what to do when the program is launched - open Assistant
or create a blank document.

Snap - enables or disables the Snap mode - the mode when objects being moved are aligned in respect to
each other. You can also temporarily disable the Snap mode if you press and hold the Cmd key while moving
an object.

Show foreground objects when editing background - use this option to see or hide objects on the foreground
layer of the design element when you are working with objects on the background layer.

By default, the program accesses the iTunes' track list by opening the "iTunes Music Library" data file. This is
the fastest way of getting the list. If you encounter problems with importing from iTunes, set the Use
AppleScript to import from iTunes option. It allows you to eliminate the problem with a wrong track order.

Measurement Units can be set to Millimeters, Inches and Points, used for entering and displaying
coordinates and dimensions of objects.
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Menus

APPENDIX B
Menus

The "Disc Cover" Menu

About Disc Cover
License...
Check for Updates...

Preferences... (Cmd+",")
Quit (Cmd+Q)

The "File" Menu

New (Cmd+N)

New from Assistant... (Cmd+Shift+N)
Open... (Cmd+0)

Open Recent >

Close (Cmd+W)

Save (Cmd+S)

Save As... (Cmd+Shift+S)

Save As Template (Cmd+Shift+Opt+S)
Export...

Design Element->Add

Design Element->Change Layout
Design Element->Delete
Calibrate Printer

Page Setup... (Cmd+Shift+P)
Print... (Cmd+P)
The "Edit" Menu

Undo (Cmd+2)
Redo (Cmd+Shift+2)
Cut (Cmd+X)

Copy (Cmd+C)
Paste (Cmd+V)
Paste with Styles (Cmd+Shift+V)

Duplicate (Cmd+D)
Delete (Del)
Find->Find... (Cmd+F)
Find->Next (Cmd+G)

Displays the dialog with information about the program.
Provides access to the registration information.

Checks for the latest updates on the Internet:
http://www.belightsoft.com/disccover/update/

Brings up the program’s Preferences dialog.

Exits the application.

Creates a new blank document.

Creates a new document with the help of the Assistant.

Opens an existing document.

Contains the list of the documents you last worked with.
Closes the active document window.

Saves the active document.

Saves the active document with a new name.

Saves the active document as a template.

Saves the active document as a graphic file (PDF, TIFF or JPEG
image).

Adds a new design element.

Changes the layout of the current design element.

Deletes the current design element.

Displays the printer calibration dialog where you can calibrate
the printer for more precise printing.

Presents the standard Mac OS X dialog for changing the size,
orientation and other parameters of the active page.

Brings up the Disc Cover print dialog.

Reverses the last operation you performed.

Reverses the last Undo operation.

Removes the selected objects or text and places the selection
onto the Clipboard.

Copies the selected objects or text onto the Clipboard.
Pastes the content of the Clipboard into the document.
Pastes text (preserving its original style) from the Clipboard
into the text box.

Duplicates the selected objects.

Removes the selected objects.

Opens the Find dialog box.

Finds another occurrence of the word or phrase entered into
the Find dialog box.
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Find->Previous (Cmd+Shift+G)
Find->Use Selection for Find (Cmd+E)

Find->Jump to Selection (Cmd+J)
Spelling->Spelling... (Cmd+":"
Spelling->Check Spelling (Cmd+";"
Spelling->Check Spelling as You Type
Select All (Cmd+A)

Special Characters (Cmd+Opt+T)
The "Insert” Menu

Image->From File
Image->Generate Random
Image->Search on the Internet
Smart Shape

Extended Text

Circle Text

Date & Time

The "View" Menu

Zoom In (Cmd+"=")
Zoom Out (Cmd+*“-")
Actual Size

Fit Width

Fit Height

Fit Page

Show/Hide Ruler (Cmd+R)

Show/Hide Margins (Cmd+\)

Show/Hide Object Borders (Cmd+Opt+\)
Show/Hide Background/Foreground

Customize Toolbar...

The "Format" Menu

Font->Show/Hide Fonts (Cmd+T)
Font->Bold (Cmd+B)
Font->ltalic (Cmd+I)
Font->Underline (Cmd+U)
Font->Bigger (Cmd+"+")
Font->Smaller (Cmd+"-")
Font->Kern
Font->Ligature
Font->Baseline
Text->Align Left (Cmd+{)
Text->Center

Text->Align Right (Cmd+})
Text->Justify

Finds previous occurrence of the word or phrase entered into

the Find dialog box.

Finds the next occurrence of a word or phrase that you have
selected in the text box.

Shows the selected object(s) in the document view.

Opens Spelling dialog.

Checks spelling.

Checks spelling as you type.

Selects all objects in the document.

Opens the Character palette.

Inserts an image from a file into the active document.
Inserts an image generated at random.

Searches images on the Internet.

Opens the list of Smart Shapes.

Inserts a text box.

Inserts a text box for circle text.

Inserts the current date and time.

Enlarges the current view.

Zooms out the current view.

Displays the document at its actual size (100%).

Scales the document so its width fits the view window.
Scales the document so its height fits the view window.
Scales the document so that the current page fits the view
window.

Shows or hides the ruler.

Shows or hides margins.

Shows or hides the borders of objects.

Opens the selected layer (background or foreground) for
editing.

Presents the toolbar sheet that allows you to customize the
toolbar.

Displays the Font dialog.
Modifies the properties of the selected text.

Increases/decreases the size of the selected text.

Modifies the properties of the selected text.

Aligns text to the left, right, center or justifies it.

BeLight Software, Ltd www.belightsoft.com

71



Disc Cover User’s Manual

Menus

Text->Writing Direction
Text->Hyphenation

Image->Edit

Image->Tile

Image->Replace Image at Import

Add Shadow

Bring Forward (Cmd+Option+F)
Bring to Front (Cmd+Shift+F)
Send Backward (Cmd+Option+B)
Send to Back (Cmd+Shift+B)
Move To Background/Foreground
Align->Left Edges

Align->Right Edges

Align->Top Edges

Align->Bottom Edges
Align->Centers Horizontally
Align->Centers Vertically
Distribute->Spacing Vertically

Distribute->Spacing Horizontally
Distribute->Centers Vertically
Distribute->Centers Horizontally

Distribute->Equal Angles

Distribute->Average Distance

Move to Center (Horizontally)
Move to Center (Vertically)

The "Window" Menu

Minimize (Cmd+M)
Bring All to Front

Import->Music
Import->Photo
Import->Video
Import->File&Folder List
Clipart->Clipart Collection
Clipart->Smart Shapes
Clipart->Custom Folder
Clipart->Image Depot
Clipart->Collages
Inspector->Design Element
Inspector->Geometry
Inspector->Fill & Shadow
Inspector->Image
Inspector->Text
Inspector->Alignment
Show/Hide Colors (Cmd+Shift+C)
Show/Hide Fonts (Cmd+T)
Toggle Clipart Panel

Toggles the writing direction

Allows hyphenation.

Opens the Edit Image dialog.

Creates a tiled image.

Turns the selected image(s) into placeholder(s) to
automatically substitute with imported images.

Adds a shadow to the selected object.

Displays the selected objects above or behind all other objects.

Moves an object to the selected layer.

Aligns the left edges of the selected objects.

Aligns the right edges of the selected objects.

Aligns the top edges of the selected objects.

Aligns the bottom edges of the selected objects.

Aligns the centers of the selected objects horizontally.

Aligns the centers of the selected objects vertically.

Creates equal vertical spacing between the edges of the
selected objects.

Creates equal horizontal spacing between the edges of the
selected objects.

Creates equal vertical spacing between the centers of the
selected objects.

Creates equal horizontal spacing between the centers of the
selected objects.

Distributes the selected objects so that angles between
imaginary axes, that go through the center of each object and
through the common center, are equal.

Places the selected objects so that the distances between their
centers and the common center are equal.

Moves selected objects horizontally to the center of the page.
Moves selected objects vertically to the center of the page.

Minimizes the currently active window.

Moves all application windows in front of the windows of other
active applications.

Opens the specified tab of the Source panel.

Opens the specified tab of the Clipart panel.

Opens the specified tab of the Inspector window.

Displays or hides the system Colors window.
Displays or hides the system Font window.
Hides/shows the Clipart panel.
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The "Help" Menu
Disc Cover Help (Cmd+?) Opens Help documentation, delivered with the application.
BelLight Software Web Site Goes to the Disc Cover’s Web page.
Useful Online Resources Useful resources on Belight Software Web Site related to Disc
Cover.

Send Feedback Lets you send your feedback to the developers by e-mail.
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APPENDIX C

Shortcuts

Working with Documents

Cmd+N
Cmd+Shift+N
Cmd+0

Cmd+W

Cmd+S

Cmd+Shift+S
Cmd+Shift+Option+S
Cmd+Q
Cmd+Shift+P

Cmd+P
Working with Objects

Cmd+Z
Cmd+Shift+Z
Cmd+X
Cmd+C
Cmd+V
Cmd+Shift+V

Cmd+D

Del

Cmd+A
Cmd+Option+F
Cmd+Shift+F
Cmd+Option+B
Cmd+Shift+B
Arrows
Arrows+Shift

Working with Windows and Dialogs

Cmd+"="
Cmd+"-"
Cmd+M
Cmd+W
Cmd+","
Cmd+Shift+C
Cmd+T
Cmd+R
Cmd+\
Cmd+Option+\

Working with Text

Cmd+B

Cmd+l

Cmd+U
Cmd+Option+"="

Cmd+Option+"-
Cmd+{

Create a new blank document.

Create a new document by using Assistant.

Open an existing document.

Close the active document.

Save the active document.

Save the active document under a new filename.
Save the active document as a template.

Quit Disc Cover.

Open the Mac OS X Page Setup dialog for adjusting the size,
orientation and other properties of the printed page.
Print the document.

Undo the last operation.

Redo the last operation.

Cut the selected objects to the Clipboard.

Copy the selected objects to the Clipboard.

Paste the content from the Clipboard into the document.
Paste text (preserving its original text style) from the Clipboard into
the text box.

Duplicate the selected objects.

Delete the selected objects.

Select all the objects in the document.

Bring Forward.

Bring to Front.

Send Backward.

Send to Back.

Move the selected objects.

Move the selected objects (increased shift movement).

Zoom In.

Zoom Out.

Minimize the active window.

Close the active document window.

Open the application’s Preferences dialog.
Display/hide the color properties dialog.
Display/hide the font properties dialog.
Show or hide the ruler.

Show or hide margins.

Show or hide objects’ borders.

Make text Bold.
Make text Italic.
Underline text.
Increase font size.
Decrease font size.
Align left.
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Shortcuts

Cmd+}

Return

Cmd+""

Cmd+""

Cmd+Opt+T

Working with the Mouse

Hold down Shift when working with
handles

Cmd+Mouse

Option+Mouse
Shift+click

Search

Cmd+F
Cmd+G

Cmd+Shift+G
Cmd+E
Cmd+J

Other

Cmd+?

Align right.

Inserts a line break in a text field.
Opens the Spelling dialog.
Checks spelling.

Open Character Palette

Invert proportional resizing to non-proportional, and vice versa.
Toggle the snap object mode on/off.

Duplicate objects.
Select/deselect object without changing other objects’ properties.

Open the Find dialog box.

Find another occurrence of the word or phrase entered into the Find
dialog box.

Find the previous occurrence of the word or phrase entered into the
Find dialog box.

Find the next occurrence of a word or phrase that you have selected
in the text box.

Show the selected object(s) in the document view.

Open the Online Help system supplied with the software.
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APPENDIX D
Troubleshooting

Printing Problems

The printer does not print
* Check cable connection between the printer and the computer.
* Make sure the printer is turned on.
* |f several printers were installed in your system, make sure the correct one is selected in the program.
* Check printer's paper source selection: some printers have several input trays.
* Make sure paper is properly loaded into the printer.

* Some printer models do not start printing when the paper output tray is closed.

Make sure that printer's initialization is finished. Lamps on printer's control panel must indicate its state.
Usually blinking lamps indicate that the printer is not ready yet.

Cannot print on CD

Let the printer complete initialization. To install the CD tray, you will usually need to open the front cover of
the printer. If you open it before the printer finishes initialization, it will not get ready.

Low Printing Quality

If your printed text or images are of low quality (light bands or gaps on the printout; the printout fades out;
you see wrong colors), check ink or toner level.

If the printout is blurry or it takes a long time for the ink to dry:
* Make sure the paper meets the printer's specification.
* The paper face is on the correct side.

* The proper paper sort is selected in the printer settings.

To establish the cause of the problem, make a test print from other software. If the problem persists, it is
likely that the problem is connected with hardware.

For more detailed guidance refer to your printer User's Manual.

Text and images are printed with a shift

To correct the shift, you should calibrate your printer.
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The printout has a blank stripe along the edge

The printed cover or label may have an unprinted stripe along the edge. Discs may also have a white ring
along the inner or outer edge.

This is possible if the selected in the program paper is of other type than one, used for printing. Or the
printable area on your CD/DVD is greater than it was set in the program.

Solutions:
1. If the unprinted stripe is even, make the Bleeds value in the Print dialog greater.

2. If the width of the unprinted stripe varies on sides, you should calibrate the printer. After calibration, the
stripe will disappear or it will get even and you fix this with the Bleeds control.
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The program cannot access the clipart moved to other location

For some reason you may want to move the clipart and design templates to another location. In this case you
should tell the program the new clipart location.

Option 1

Using the program's preferences

Move the folder with the internal clipart to a new location. Let's suppose, you are moving the "BeLight
Software" folder from "/Library/Application Support" to another folder on your disk.

Leave the new clipart location open in Finder, you will use it later.

1. Open the Terminal application from the Applications/Utilities folder.
2. Copy the following line to the Clipboard (Cmd+C)
defaults write com.belightsoft.DiscCover FTUseSharedContentLibrary -bool true
and paste into the Terminal window (Cmd+V).
3. Press the Return button.
4. Copy the following line to the Clipboard (Cmd+C)
defaults write com.belightsoft.DiscCover FTSharedContentLibraryPath
and paste into the Terminal window (Cmd+V).
5. Press the Space button.
6. Drag the Belight Software folder from Finder (new location) onto the Terminal window.
You will get similar line in terminal:

defaults write com.belightsoft.DiscCover FTSharedContentLibraryPath

The end of the command line (shown in gray only for your reference) will be different because it shows your
own clipart location.

The shown sample command writes the default path to the clipart.

7. Press the Return button.

Note: do not add any extra symbols including spaces.
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Option 2

Using folder's alias

Move the folder with the clipart to a new location. Let's suppose, you are moving the "BeLight Software" folder
from "/Library/Application Support" to another folder on your disk.

Leave the new clipart location open in Finder, you will use it later.

1. Open the Terminal application from the Applications/Utilities folder.
2. Copy the following line to the Clipboard (Cmd+C)
In-s
and paste into the Terminal window (Cmd+V).
3. Press the Space button.
4. Drag the BelLight Software folder from Finder (new location) onto the Terminal window.
5. Press the Space button.
6. Copy the following line to the Clipboard (Cmd+C)
~/desktop/BeLight\ Software

and paste into the Terminal window (Cmd+V).
The line in Terminal will look like the following:

In-s ~/desktop/BeLight\ Software
Note, the middle part (shown in gray) will reflect actual path to the folder on your computer.
7. Press the Return button.

An alias will be created on your Desktop.

8. Move the alias to the "/Library/Application Support/" folder (default location of the clipart and templates).

Note: using an alias is more universal. If you have several products from BeLight Software, they share the
same folder with supporting files. So, making an alias will give all the programs access to the moved folder.
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Cannot import from iTunes

The program supports two methods of importing. If no data is imported, try to set the Use AppleScript to
import from iTunes option in the program preferences (Cmd+,) and start importing again.

If the problem stays, you can still import via a text file (this is the most reliable way):
1. Open iTunes.
2. On the Source panel select a play list or the whole library.

3. Select the File / Export Song List command in the iTunes' menu. Choose file name and folder to export,
set "Plain Text" as "Format" and click the Save button.

4. Import data from the text file into Disc Cover. See Chapter 6, "Importing Data from a Text File", for details.
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The program imports wrong track order from iTunes

The problem arises because iTunes does not update the
~(Your Home)/Music/iTunes/iTunes Music Library.xml

file that is used for getting library content. You can delete the file and iTunes will create it again at next
launch.

The alternative way is to set the Use AppleScript to import from iTunes option in the program preferences
(Cmd+)).
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Appendix E
Using Image Generators

Generating Images

Having Image Tricks plug-ins installed, you can generate images using special mathematical algorithms. If
Image Tricks was not installed, the internal image generator will be used instead.

Image Tricks plug-in works on Mac OS 10.4 and higher. To download Image Tricks, use the following link:

http://www.belightsoft.com/imagetricks

To access generators, go to the Image Depot tab on the Source panel (menu: Window / Clipart / Image
Depot) and click the Generate button.

Some Generators (like Spinning Squares) show the same image if same parameters were set, some can give
random images (Star Field). To get another randomly generated image, click the Render button.

If you decide to open one of the previously generated but not saved images, use the "<" and ">" buttons.
When you select a generator, the program shows an image, generated with the default set of parameters.

Tip:

[t may take time for some generators to show a picture. If you just play with parameters (especially color) to
find an appropriate combination, it is recommended to set smaller image size. 200x200 pixels is enough for
preview. Then you can change image size and re-generate it in better quality.

Generator Parameters

Generators have different sets of parameters. Parameters can be

separated into the following groups: USTOF | prichee
. GENERATORS Spinning Polygons

Shape - some generators use a number of smaller images to create a :
bigger one and you can select one to use. | atoms .
Numeric parameters such as angle, size, resolution and other. [ Shape:

Density: —
Color Scheme - determines how many colors to use in the image. The - 350
base color is taken from the "Color" control. ;—n— T

ide: E———

GENERATOR | —&——— § =

- Opposite - two colors (selected color and a complementary one) and up PARAMETERS
to four of their tints.

Color Scheme: | Opgose 1%

| Back Color: -l

- Triadic - three colors (selected one and two complementary) and up to
four of their tints.

- Tetradic - four colors (selected one and three complementary) and up to
four of their tints.

HISTORY OF  GENERATE
GEMERATED IMAGES: ANOTHER
- MonoStep - one base color and four of its tints. SHOW PREVIOS / NEXT IMAGE

- MonoBlack - one base color and four of its tints, darker than the base one.
- MonoWhite - one base color and four of its tints, lighter than the base one.

- Mono - one base color with unlimited number of tints.
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The color selector is one of these types:
- Color
- Color Range

You can move color sliders separately. To move them together, drag any of them holding the Shift key.

Back Color - color of the image background. It is applicable to images with the transparent background.

Image Size

To change or verify the image size, click the Size button.
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